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Chapter 1 — General Information

1-1 Introduction
The PIM Master MW82119B User Guide is part of a set of manuals that cover all of the 
instrument functions and their use. The PIM Master with Site Master option is capable of 
performing a wide variety of Passive Intermodulation (PIM) and Line Sweep measurements. 
This guide provides a quick-start section with a brief overview of the available PIM and Line 
Sweep measurements. Please refer to the measurement guides described below for more 
detailed measurement instructions. This guide also provides a summary of the hardware and 
software features of the PIM Master that are common to all measurement modes. 

Additional Documentation 
  

Read the Handheld Instruments Product Information, Compliance, and Safety Guide 
(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the 
equipment. For additional information and literature covering your product, visit the product 
page of your instrument and select the Library tab:

• http://www.anritsu.com/en-US/test-measurement/products/mw82119B 

Note
Throughout this user guide, screen images are provided as examples. The image 
and measurement details on your instrument may differ from the examples in this 
user guide.

Document Part Number Description (Required Option)

10100-00065 Important Product Information, Compliance, and Safety Notices

10580-00240
Power Meter Measurement Guide
High-Accuracy Power Meter (Option 19)

10580-00241
Cable and Antenna Analyzer Measurement Guide 
Cable and Antenna Analyzer (Option 331)

11410-00824 PIM Master Product Brochure 

11410-00821
PIM Master Technical Data Sheet
Performance Specifications

10580-00402 Passive Intermodulation Analyzer Measurement Guide

10580-00403 PIM Master MW82119B Programming Manual

10580-00401 PIM Master MW82119B Maintenance Manual

11410-00784 Configuring the Anritsu PIM Master for Wireless Browser Control

10580-00252 Site Master User Guide

Note
PIM is a measure of system linearity as compared to line sweeping, which is a 
measure of system impedance. Both tests are critical to validate a cellular system.
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Document Conventions

Main menus and keypad buttons are shown in the user guide using a Serif Bold typeface. 
Main menus are the buttons displayed at the bottom of the touchscreen. Submenus and 
submenu buttons are displayed on the right side of the touchscreen display and shown in the 
user guide using Serif Regular typeface. 

Menu and button locations may be described in this document by their path: 

   Measurement > VSWR 

The line above reads as “Press the Measurement main menu, then press the VSWR button."

Contacting Anritsu for Sales and Service 

To contact Anritsu, please visit:

http://www.anritsu.com/contact-us 

Here, you can find sales, customer service, and support contact information for your country 
or region, provide online feedback, complete a “Talk to Anritsu” form to have your questions 
answered, or obtain other services offered by Anritsu.

Updated product information can be found on the Anritsu web site:

http://www.anritsu.com/

Search for the product model number. The latest documentation is on the product page under 
the Library tab.

Example URL for MW82119B: 

http://www.anritsu.com/en-US/test-measurement/products/mw82119B
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1-2 Instrument Description
Anritsu has developed the PIM Master, with Site Master option, to fully characterise the RF 
performance of transmission systems with a single test instrument. Previously, two separate 
analyzers were required to measure Passive Intermodulation (PIM) and impedance 
mismatches in RF transmission lines. With Site Master Option 331 installed, the PIM Master 
can now perform both of these tests to ensure minimum signal degradation, minimum noise 
generation, and maximum signal throughput. Test capabilities with Option 331 installed 
include:  

• PIM vs. TIME

• Swept PIM

• Noise Floor

• Distance-to-PIM

• Return Loss

• VSWR

• Cable Loss

• Distance-to-Fault (DTF)

PIM Master Options 

Table 1-1 lists the current available options. Refer to the Anritsu web site for the latest 
information on available PIM Master options and frequency ranges.  

Table 1-1. PIM Master Options

Instrument Option Description

MW82119B-0700 LTE 700 MHz (Lower and Upper)

MW82119B-0701 APT 700 MHz

MW82119B-0800 LTE 800 MHz

MW82119B-0850 Cellular 850 MHz

MW82119B-0900 E-GSM 900 MHz

MW82119B-0902 E-GSM 900 MHz with IM2

MW82119B-0180 DCS 1800 MHz

MW82119B-0194 PCS/AWS 1900/2100 MHz

MW82119B-0210 UMTS 2100 MHz

MW82119B-0260 LTE 2600 MHz

MW82119B-0331 Site Master Cable and Antenna Analyzer

MW82119B-0031 GPS Receiver (requires antenna)

MW82119B-0019
High Accuracy Power Meter
(requires external power sensor)

MW82119B-0098  Standard Calibration Certification

MW82119B-0099 Premium Calibration Certification

Note
For ordering information and for option and accessory part numbers, refer to the 
technical data sheet (listed in Appendix A).
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1-3 Instrument Care and Preventive Maintenance
Site Master care and preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and all accessories. Clean the Site Master with 
a soft, lint-free cloth dampened with water or water and a mild cleaning solution.

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 
N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether 
the connectors are undamaged, gauge the connectors to confirm that the dimensions are 
correct. Visually inspect the test port cable(s). The test port cable should be uniform in 
appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). 
Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can 
damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or 
connector rings. Repair or replace damaged connectors immediately. Dirty connectors can 
limit the accuracy of your measurements. Damaged connectors can harm the instrument. 
Connection of cables carrying an electrostatic potential, excess power, or excess voltage can 
damage the connector, the instrument, or both.

Connecting Procedure 

1. Carefully align the connectors.

The male connector center pin must slip concentrically into the contact fingers of the 
female connector.

2. Push connectors straight together. Do not twist or screw them together.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. When you use a torque wrench, initially tighten by hand so that approximately 1/8 turn 
or 45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over torque the connector.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.
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Test Cable from PIM Master to DUT   

Remove O-rings from the test cable and be sure that the connectors are clean. If the 
DUT connector has an O-ring, then use a torque wrench to tighten the connector. 

Disconnecting Procedure 

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning 
while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

Connector Saver       

Anritsu recommends attaching an adapter to the 7/16 DIN female RF Out connector and 
using the adapter for the working connector. This connector saver reduces wear on the 
instrument PIM Test connector. Typically, 500 matings is the life of a connector for PIM 
testing. The connector saver can remain on the PIM Master inside the soft case.

4. Adapter: 7/16 DIN(f) to 7/16 DIN(m), 50 Ω (Connector Saver). One connector saver is 
provided with your test instrument. Replacement connector savers can be purchased 
from Anritsu. The part number is in your Technical Data Sheet.

Note

When testing, cables are connected and disconnected many times. In order to 
save wear on these test cables and RF adapters, Anritsu recommends removing 
the O-rings. This allows getting a sufficiently tight connection without unnecessary 
stress on the connectors. In the field, O-rings are important to maintain connection 
integrity over long time periods. Connections must be torqued to specifications in 
order to ensure that they prevent water intrusion.

During your test, if the DUT connector has an o-ring, leave it in place and tighten 
to the correct torque.
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ESD Caution    

The PIM Master, like other high performance instruments, is susceptible to electrostatic 
discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which 
(if allowed to discharge by connecting directly to the PIM Master without discharging the 
static charge) may damage the PIM Master input circuitry. 

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these apply to the PIM Master, Anritsu recommends that 
any static charges that may be present be dissipated before connecting coaxial cables or 
antennas to the PIM Master. This may be as simple as temporarily attaching a short or load 
device to the cable or antenna prior to attaching to the PIM Master. It is important to 
remember that the operator may also carry a static charge. Following the practices outlined 
in the above standards will ensure a safe environment for both personnel and equipment.

Battery Information 

The batteries that are supplied with the PIM Master may need charging before use. They can 
be charged using either the AC-DC Adapter or the DC adapter. The batteries can also be 
charged by using an external charger (refer to your Technical Data Sheet). Refer to 
Section E-3 “Battery Care” on page E-2.  

The PIM Master batteries can be replaced without the use of tools. The battery compartment 
access is on the bottom of the PIM Master. Refer to Section E-4 “Battery Replacement” 
on page E-3.

Caution
Operators must be aware of the potential for ESD damage and take all necessary 
precautions.

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this 
instrument.

The batteries charge at a faster rate when the instrument is turned off. Charging 
the batteries while the instrument is running requires a longer time to reach a full 
charge.

To prolong the useful battery life, the internal charging circuit monitors the battery 
temperature. Normal charging occurs when the battery temperature is between 
0 °C and 45 °C. Charging is paused if the internal battery temperature is beyond 
this range.

Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Caution

When using the Automotive Cigarette Lighter Adapter, always verify that the 
supply is rated for a minimum of 40 Watts at 12 VDC, and that the socket is clear 
of any dirt or debris. If the adapter plug becomes hot to the touch during operation, 
then discontinue use immediately.
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PIM Master Firmware Update

Refer to Section E-5 “PIM Master Firmware Update” on page E-6 for firmware upgrade 
procedures.

1-4 Calibration Requirements 
Field calibrate your PIM Master as required to achieve acceptable residual PIM. The 
instrument provides calibration prompts to help you determine calibration status. Anritsu 
recommends annual factory calibration and performance verification by local Anritsu 
service centers. The Cable and Antenna Analyzer mode requires calibration standards for 
OPEN, SHORT, and LOAD (OSL), which are sold separately.

1-5 Wireless Remote Control
Browser based control allows you to remotely control the PIM Master from any Wi-Fi enabled 
device with web browser software (Chrome or Firefox preferred). This includes a wide range 
of tablets and phones running Android or iOS operating systems as well as the traditional 
Linux and Windows laptop and desktop computers.

Wi-Fi links are useful in the field, particularly when the PIM Master is on a tower, and you 
are on the ground.

For wireless remote control, a Wi-Fi router must be connected to the PIM Master.

Refer to Appendix C, “Wireless Remote Control” for more details on using this capability to 
enable wireless control.

Note
Anritsu recommends allowing the instrument to warm up to typical operation 
temperature (approximately 15 minutes) before calibrating.
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Chapter 2 — PIM Master Overview

2-1 Introduction
This chapter provides a description of the MW82119B PIM Master. It also includes a brief 
description of preventive maintenance, calibration requirements, and additional PIM Master 
documents. 

2-2 Turning On the PIM Master for the First Time
The Anritsu MW82119B PIM Master is capable of more than 3.0 hours of continuous 
operation from a fully charged, field-replaceable battery (refer to Section E-4 “Battery 
Replacement” on page E-3). The PIM Master can also be operated from a 12 VDC source 
(which will also simultaneously charge the battery). This can be achieved with either the 
Anritsu AC Adapter or Automotive 12 Volt Adapter. Both items are included as standard 
accessories (refer to the list of accessories in the Technical Data Sheet for your specific 
instrument, as listed in Appendix A). 

To turn on the MW82119B PIM Master, press the On/Off button on the front panel 
(Figure 2-3 on page 2-4). The PIM Master takes approximately forty seconds to complete 
power-up and to load the application software. At the completion of this process, the 
instrument is ready to be used. 

Warning

The Anritsu PIM Master is capable of producing 80 Watts of RF power in the 
cellular communications bands. Users must take precautions to minimize 
exposure to these RF fields: 

Always terminate the PIM output port of the test equipment into a load, a 
loaded line, or a line that will radiate or absorb the energy before beginning 
a PIM test. 

Confirm that the PIM Master RF power is off after a PIM test. 

Always confirm that the PIM RF power is off before disconnecting a coaxial 
connection, otherwise RF burns may result. Immediate burns to fingers or 
eyes can result from exposure to live connectors. 

Ensure that all antennas under test are placed so that no personnel are 
exposed to RF levels that exceed the maximum allowable exposure. 

Caution 

When using the Automotive Adapter, always verify that the supply is rated for a 
minimum of 60 Watts at 12 VDC and that the socket is clear of any dirt or debris. If 
the adapter plug becomes hot to the touch during operation, then discontinue use 
immediately.

Note
Anritsu recommends that you turn on your PIM Master and let it warm up for 
10 minutes before performing your first calibration.
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Calibration Due Date   

On first use, or if the Calibration Reminder setting is greater than the due date, a menu is 
displayed requesting that you enter the Calibration Due Date for this instrument. This date is 
available on the calibration sticker that is provided with the instrument. Enter the correct 
day, month, and year and then press Enter. 

The initial calibration due date is set to one year from the Factory Calibration Date, unless 
you enter a different date.

Figure 2-1. Calibration Due Date Dialog Box

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Chapter 2 — PIM Master Overview 2-3 Front Panel Overview

MW82119B UG PN: 10580-00400  Rev. J 2-3

Calibration Reminder  

You can set a reminder of the due date by pressing the Days Before Calibration Reminder 
submenu key and entering a number with the number keypad. Complete the entry by 
pressing the Enter submenu key or the instrument Enter key. 

2-3 Front Panel Overview 
The PIM Master menu-driven interface is easy to use and requires little training. The 
PIM Master uses a touch screen and keypad for data input. The five bottom menu keys and 
eight submenu keys on the right side are touch screen keys. The menu and submenu keys will 
vary depending upon the selected mode of operation, refer to “Mode Selector Menu” 
on page 2-21.

Number keys 1 through 9 are dual purpose, depending upon the current mode of operation. 
The dual-purpose keys are labeled with a number on the key itself with the alternate function 
printed in blue above each of the keys. Use the blue Shift key to access the functions printed 
on the panel. The Escape key, used for aborting data entry, is the button located above 
number key 8. The four Arrow keys and the keypad can be used to change the value of an 
active parameter. 

Figure 2-2. Days Before Calibration Reminder 
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MW82119B PIM Master Front Panel  

Figure 2-3. MW82119B PIM Master Front Panel

1. On/Off Button

2. Number Keypad

3. Measurement Display (a Touch Screen)

2

1

3
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2-4 Front Panel Keys      

The terms button and hard key refer to all of the buttons on the instrument face. These keys 
perform as follows:

Menu Key 

(item 1 in Figure 2-4)

Press the Menu key to display the Menu Key Screen, a grid of shortcut icons for installed 
measurement modes and user-selected menus and setup files. 

Figure 2-4. Front Panel Layout

1. Menu Key

2. Speaker Grill

3. LED Indicators for Battery Charge and Power

4. On/Off Button

5. Arrow Keys and Enter Key in center

6. Shift Key and Escape Key

7. Number Keypad

1 42

5

7

6

3
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LED Indicators (above the On/Off Button)

(item 3 in Figure 2-4)

Battery Charge LED (Green) 

The Battery Charge LED flashes if the battery is charging, and remains on steady when the 
battery is fully charged. 

Power LED (Green) 

The Power LED remains on when the PIM Master is on.

On/Off Button 

(item 4 in Figure 2-4)

Press this button to turn on power to the PIM Master. Press and hold this button to turn off 
power. 

Arrow Keys 

(item 5 in Figure 2-4)

The four Arrow keys are used to scroll up, down, left, or right. The Arrow keys can often be 
used (depending upon measurement selection) to change a value or to change a selection from 
a list. In some measurements, the Left/Right arrow keys change values by different 
increments than the Up/Down arrow keys. The Arrow keys are also used to move markers.

Enter Key 

(item 5 in Figure 2-4)

Press this key to finalize data input.

Shift Key 

(item 6 in Figure 2-4) 

Press the Shift key and then press a number key to open the menu that is indicated in text 
above the key number. When the Shift key is active, its icon is displayed at the top-right of 
the measurement display area between the battery charge indicator and the submenu key 
labels. 

Esc Key 

(item 6 in Figure 2-4)

Press this key to cancel any setting that is currently being made.

Figure 2-5. Shift Key Icon
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Number Keypad 

(item 7 in Figure 2-4)

Press these keys to directly input numbers. Number keys are also used to open menus when 
used with the “Shift Key”. For example, press Shift and Touch (0) to initiate Touch Screen 
Calibration.

+/– Key 

(item 7 in Figure 2-4)

Press this key to change the sign of numbers that are entered with the number keys.
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2-5 Top Connector Panel  
The top connector panel includes the test port connectors and the Radio Frequency On light.  

PIM Radio Frequency ON Light  

(item 1 in Figure 2-6)

This red indicator is illuminated when PIM RF output power is On.

PIM Test Connector  

(item 2 in Figure 2-6)

Type 7/16 DIN(f), 50 Ω test port connector that is used to perform PIM versus Time, Swept 
PIM, Noise Floor, and Distance-to-PIM (DTP) measurements. 

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the DIN 
connector. Do not over-tighten the connector. The recommended torque is 25 N·m (~18 lbf·ft). 
To prevent rotation, secure the PIM test connector or the recommended connector saver with 
a wrench when attaching a test lead.

The PIM Master fits into its soft carrying case and transit case with a 7/16 DIN, female, 50 Ω 
connector saver attached. Refer to “Connector Saver” on page 1-5.

Figure 2-6. PIM Master Top Panel Layout 

1. Indicator Light for RF On (Red)

2. PIM Test Connector, 7/16 DIN, female, 50 Ω

3. VNA RF Out Connector, Type-N, female, 50 ohms (Option 331)

4. IM2 In Connector, Type-N, female, 50 ohms (Option 902) 

5. Strap Bracket (shown without strap)

1 32 54
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VNA RF Out Connector    

(item 3 in Figure 2-6)

VNA RF Out Connector, Type-N, female, 50 ohms (Option 331). This test port is available 
only on instruments with Site Master Option 331. It is used to perform Return Loss, VSWR, 
Cable Loss, and Distance-to-Fault (DTF) measurements. Hand tighten this connection. Do 
not use a wrench.

IM2 In Connector   

(item 4 in Figure 2-6)

IM2 In Connector, Type-N, female, 50 ohms (Option 902). This test port is available only with 
frequency Option 902. It is used to receive second order intermodulation products. Hand 
tighten this connection. Do not use a wrench.

Strap Bracket 

(item 5 in Figure 2-6)

The Strap Brackets hold the Handle Strap and can accommodate a Carabiner. Note that each 
bracket is secured to the PIM Master with 2 screws. The handle is sewn to the brackets, but is 
not shown in the figure in order to reveal the bracket design. See Figure 2-22 on page 2-31 for 
the complete bracket, mounted and in use.
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2-6 Side Panel Connectors
The side connector panel includes connectors for External Power, Ethernet/LAN, USB 
interface, and GPS.  

Figure 2-7. PIM Master Side Panel Overview

1. External Power

2. LAN Connection, RJ45

3. USB Interface, Type A 

4. USB Interface, 5-pin mini-B 

5. Auxiliary 1 (factory use only)

6. Auxiliary 2 (factory use only)

7. GPS Connector, SMA female (with Option 31) 

8. Legend (icons identify connection types)

7

5

1

3

2

4

6

8
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External Power 

(item 1 in Figure 2-7)  

This 2.1 mm by 5.5 mm barrel connector is used to power the unit and for battery charging. 
Input is 12 VDC to 15 VDC at up to 5.0 A.  

LAN Connection 

(item 2 in Figure 2-7) 

The RJ45 connector is used to connect the PIM Master to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. For additional information about the LAN connection, 
Ethernet connection, and DHCP, refer to Appendix F, “LAN and DHCP”.

USB Interface – Type A 

(item 3 in Figure 2-7)  

This interface has two connectors for flash drive and USB Power Sensor. The MW82119B 
PIM Master can also be a USB Host and allow various USB Flash Memory devices to be 
connected to the instrument for storing measurements, setups, files, and firmware upgrades. 
Either USB connection can be used with a USB power sensor (but only one power sensor at a 
time).

USB Interface – Type Mini-B 

(item 4 in Figure 2-7)  

The USB 2.0 interface can be used to connect the MW82119B PIM Master directly to a PC for 
data transfer. The first time the PIM Master is connected to a PC, the normal USB device 
detection by the computer operating system will take place. Drivers are available for 
Windows XP (or later). 

Warning

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, then the user is at risk of receiving a severe or fatal 
electric shock.

Note
For proper detection, Line Sweep Tools should be installed on the PC prior to 
connecting the PIM Master to the USB port.
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GPS Antenna Connector (Option 31) 

(item 7 in Figure 2-7)   

The GPS antenna connection on the PIM Master is type SMA(F). Selectable +3 VDC or 
+5 VDC antenna power.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
SMA connector. Do not overtighten the connector. The recommended torque is 8 lbf·in 
(0.9 N·m or 90 N·cm).

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Chapter 2 — PIM Master Overview 2-7 Front Panel Overview

MW82119B UG PN: 10580-00400  Rev. J 2-13

2-7 Front Panel Overview
Throughout this manual, typical measurement displays are shown for the basic measurement 
modes of the PIM Master. Note that the images shown in this manual may be different from 
any images that are displayed on your PIM Master.

Front Panel Display Areas 

Figure 2-8. Front Panel Overview

Date/Time GPS Battery Indicator

Measurement Title Area

Main Graph Area

Submenu
Keys

Main Menu Keys

Numerical Measurement Result Area

Instrument
Settings
Summary
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Main Menu Keys 

The PIM Master menu-driven interface is easy to use and requires little training. The 5 Main 
Menu keys are located below the measurement display. These 5 keys are used to display the 
function-specific menus in the active menu (submenu labels). These Main Menu keys vary in 
function based on the selected mode of operation (Shift, Mode (9)) or measurement type 
within a mode. Refer to “Mode Selector Menu” on page 2-21 for more information on changing 
the instrument mode. Table 2-1 lists from left to right the Main Menu Key labels for each 
mode of instrument operation. 

Submenu Keys

The 8 submenu keys are located to the right of the measurement display. They change 
function depending upon the current mode and current menu selection. The current submenu 
title is shown at the top of the active function block (submenu key labels). Refer to Figure 2-9 
on page 2-15.

Table 2-1. Mode-Dependent Main Menu Keys Located Below Measurement Display 

Mode/Measurement
Type Key 1 Key 2 Key 3 Key 4 Key 5

PIM vs. Time Freq Amplitude Setup Measurements Marker

Noise Floor Freq Amplitude Setup Measurements Marker

DTP Distance Amplitude Setup Measurements Marker

Swept PIM Freq Amplitude Setup Measurements Marker

High Accuracy 
Power Meter

Amplitude Average Zero/Cal Limit

Cable & Antenna Freq/Dist Amplitude Sweep/Setup Measurements Marker
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Front Panel Layout, PIM vs. Time

The following three figures are provided to identify display components in different 
measurement modes. The image and measurement details shown on your instrument may 
differ from the examples in this user guide.  

2-

Figure 2-9. Front Panel Layout with PIM vs. Time Display

1. Real Time Clock (followed by GPS Coordinates if Option 31 is installed)

2. Main Graph Area or Sweep Window or Measurement Grid

3. Limit Line (Green line, set from Limit menu)

4. Battery Status Icon

5. Instrument Mode and Measurement Title

6. Submenu Keys or Active Function Block

7. PIM Summary Table

8. Pass/Fail Indicator (set from Limit menu)

9. Main Menu Keys

10. Instrument Settings Summary

1 3

710 9

2 54 6

8
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Front Panel Layout, Distance-to-PIM  

Figure 2-10. Front Panel Layout with Distance-to-PIM Display

1. Real Time Clock (followed by GPS Coordinates if Option 31 is installed)

2. Reference Limit Line (blue line, set from Limit menu)

3. Main Graph Area or Sweep Window or Measurement Grid

4. Marker on Distance-to-PIM Measurement Trace

5. Battery Status Icon

6. Instrument Mode and Measurement Title

7. Submenu Keys or Active Function Block

8. Progress Indicator

9. Marker Table (set to Large)

10. Main Menu Keys

11. Instrument Settings Summary

11 10

1 3 654 72

89
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Front Panel Layout, Swept PIM  

Figure 2-11. Front Panel Layout with Swept PIM Display

1. Real Time Clock (followed by GPS Coordinates if Option 31 is installed)

2. Main Graph Area or Sweep Window or Measurement Grid

3. Swept PIM Measurement Trace (green trace and yellow trace)

The yellow trace is created by holding F1 fixed and sweeping F2. The green trace is 
created by holding F2 fixed and sweeping F1. The PIM Summary Table displays the 
frequencies that are used to generate each sweep. In this display, the green trace 
(Sweep #2) is visible only in the first few MHz of the sweep. Note that the PIM 
Summary Table displays the Sweep numbers in yellow and green.

4. Battery Status Icon

5. Instrument Mode and Measurement Title

6. Submenu Keys or Active Function Block

7. PIM Summary Table

8. Limit Line (green)

9. Progress Indicator

10. Main Menu Keys

1 3

711 10

2 54 6

13

9 8

12
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11. Instrument Settings Summary

12. Pass/Fail indicator

13. Marker data automatically displayed
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Front Panel Layout, C&AA (Option 331)   

Figure 2-12. Front Panel Layout with Return Loss Display

1. Real Time Clock (followed by GPS Coordinates if Option 31 is installed)

2. Main Graph Area or Sweep Window or Measurement Grid

3. Limit Line (green) 

4. Battery Status Icon

5. Instrument Mode and Measurement Title

6. Submenu Keys or Active Function Block

7. Marker Table

8. Return Loss Measurement Trace

9. Main Menu Keys

10. Instrument Settings Summary

11. Marker data automatically displayed for active Marker [M2]

1 3

710 9

2 54 6

8

11
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2-8 Secondary Function Menus  
Pressing the Shift key and then a number key selects the menu function that is printed above 
the key number (Figure 2-13). 

Not all Secondary Function Menus are active in various operation Modes. If any one of these 
menus is available in a specific instrument Mode of operation, then it can be called from the 
number keypad. It may also be available from a main menu key or a submenu key. The ten 
Secondary Function Menus are:

0 Touch Screen Calibration (and Arrow Navigation)

1 Preset

2 Calibration

3 Sweep

4 Measurements

5 Trace

6 Limit

7 File

8 System

9 MODE

Figure 2-13. Keypad and Secondary Function Menus 
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2-9 Mode Selector Menu  
To access the functions under the Mode menu, select the Shift key, then the Mode (9) key. 
Use the directional Arrow keys to highlight the selection, and press the Enter key to select. 
The list of modes that appears in this menu will vary depending upon the options that are 
installed and activated in your instrument. Figure 2-14 is an example of the Mode menu. 
Your instrument may not show the same list. 

Figure 2-14. Mode Selector Menu
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2-10 Menu Key 
Press the Menu key to display the Menu Key Screen, a grid of shortcut icons for installed 
measurement modes and user-selected menus and setup files. 

Figure 2-15 shows the Menu key screen. Touch one of the icons in the top two rows to change 
modes. The icons that are shown here are preinstalled and cannot be moved or deleted. The 
display of the Menu screen will vary depending on instrument model, firmware version, and 
installed options. Note that the High Accuracy Power Meter icon is present only if Option 19 
is installed. The image in Figure 2-15 may differ from the menu on your instrument. 

Figure 2-15. Menu Key Screen, Icons for Installed Measurements and Shortcuts
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Figure 2-16 shows the Menu key screen with shortcut icons for the installed measurement 
modes and additional user-defined shortcuts to menus and setup functions. 

Press and hold down any key for a few seconds to add a shortcut to this screen. For example, 
to create a shortcut for PIM versus Time measurements, open the Measurements menu and 
hold down on the PIM vs. Time submenu key for several seconds. Then select the location for 
the shortcut. The display of the Menu screen will vary depending on instrument model, 
firmware version, and installed options. The image in Figure 2-16 may differ from the menu 
on your instrument. 

User-defined shortcuts stay in memory until deleted. To delete or move a shortcut button, 
press the Menu key, then press and hold the shortcut for approximately 3 seconds. The 
Customize Button dialog box opens to allow a button to be deleted or moved. Press Esc to exit 
the Menu shortcut display. 

Figure 2-16. Menu Key Screen

Note

The Master Reset will delete all user-created shortcut icons from the Menu screen. 
Refer to the “Reset Menu” on page 5-7 for additional information.

To retain shortcuts during a firmware update, select the "Save & restore user data" 
option shown in Figure E-5 on page E-8.
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Help for the Menu shortcut screen is available by pressing the question mark icon in the 
lower-right corner of the display. 

Figure 2-17. Menu Help
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2-11 Touch Screen  
The touch screen and keypad are used for data entry. The sweep window and surrounding 
screen areas provide measurement information (see Figure 2-8, “Front Panel Overview” 
on page 2-13). 

Graphical User Interface (GUI) 

The measurement display, or sweep window, provides measurement trace data. Above the 
grid and trace data, additional measurement data is displayed, and the analyzer mode is 
shown in the top-right corner. The lower area of the grid may be reduced in size to display an 
optional data window, such as a table of measurement data or marker data. To the left of the 
grid and trace data is the instrument settings summary, below the grid are the five main 
menu touch keys, and to the right are the submenu touch keys. For a list of the main menu 
keys in different instrument modes, refer to “Main Menu Keys” on page 2-14.

The five main menu touch keys and (up to) eight submenu touch keys are available in all 
analyzer Modes, providing control of measurement settings. In addition, you can touch other 
areas of the display screen to perform tasks that are also available from the menu keys. 

For example:   

• If you touch the Scale setting on the left side of the display (Instrument Settings 
Summary), then the Amplitude menu is displayed, and the Scale submenu key is 
active. Scale is displayed in PIM vs. Time and Swept PIM measurements.

• If you touch Data Points (Instrument Settings Summary), then the DTP Parameters 
setup window is displayed, and the Data Points parameter is selected (Distance-to-PIM 
measurements.

•  If you touch Cable (Instrument Settings Summary), then the Cable List is displayed 
(Distance-to-PIM measurements).

• If you place a marker on the screen, then you can touch the measurement trace to 
relocate the marker. 

• If you touch the file type list box in one of the file management dialog boxes, then you 
can open the Filetype drop-down list to select a file type.

Main Menu Touch Screen Keys 

The main menu key functions change to match specific instrument Mode settings. The main 
menu keys generate function-specific submenus. The measurement modes are selected by 
pressing the Shift key and then the Mode (9) key. For more details about the Mode menu, 
refer to “Mode Selector Menu” on page 2-21.

Submenu Touch Screen Keys 

The submenu touch keys are located in the active function block (submenu key labels) along 
the right edge of the display. The submenu labels change as instrument measurement and 
parameter settings change. The current submenu title is shown at the top of the submenu key 
block. An example of the keys is shown in Figure 2-9 on page 2-15. Additional details are 
described in Section 2-7 “Front Panel Overview” on page 2-13.
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2-12 Touch Screen Calibration  
The Calibrate Touch Screen submenu key is in the “System Menu” on page 5-3. When pressed, 
the touch screen calibration message box is displayed with instructions for calibration. 
Calibration optimizes the response of touch input. You touch targets in sequence as they are 
displayed on the touch screen. This requires less than one minute.

Calibration is recommended if your touch inputs do not correspond to the appropriate 
locations on the screen. After the information box is displayed, press Enter to begin 
calibration, or press Esc to cancel.

You can also press 1 to use arrow navigation.

Calibrate Touch Screen Shortcut 

You can access touch screen calibration by pressing Shift then Touch (0). This displays the 
touch screen calibration message box. Press Enter to begin calibration, or press Esc to cancel. 
This shortcut can be used if your touch inputs do not correspond to the appropriate locations 
on the screen to such an extent that you cannot access the Calibrate Touch Screen submenu 
key.

Arrow Navigation    

If the touch screen is not functioning, you can use Arrow Navigation to simulate pressing the 
touch screen main menu keys and submenu keys. From the touch screen calibration message 
box, press 1 to use arrow navigation. This displays the arrow navigation message box. Press 1 
again to enter the arrow navigation mode, or press Esc to cancel. Note that entering arrow 
navigation mode disables the touch function of the touch screen.

In arrow navigation mode, a red selection box surrounds a key (see Figure 2-18 on page 2-27 
in which the Carrier F1 submenu key is selected). To move the red selection box, use the 
Arrow keys above the number keypad (see Figure 2-13 on page 2-20). Then press the Menu 
key to activate the selected touch screen key. Note that only the main menu keys and 
submenu keys can be activated by using Arrow Navigation. When using the File management 
menus for Copy, Recall, and Delete, however, you can press the +/– key to change focus of the 
arrow navigation from the menu keys to the lists in the dialog box and back to the menu keys. 
Arrow navigation places a green selection box around the Source or Destination file group 
(depending on the selection toggled in the Scroll submenu key). You can then use the arrow 
keys to navigate and select files. This feature does not move the arrow navigation selection 
box into any other areas of the touch screen.

To save a measurement in arrow navigation mode, press Shift then File (7). Use the Arrow 
keys to move the red selection box to the Save Measurement As submenu key. This submenu 
key must be used because the arrow navigation mode cannot be used to change data in popup 
windows in the measurement display. Filenames are determined by the current setting of the 
Save Measurement As submenu key. Refer to “Save Measurement As” on page 4-12.

You can save a JPEG image of the current display screen by pressing three keys, Shift, then 
Decimal, then +/–. The JEPG image shows screen data, but does not contain the additional 
measurement information that accompanies a saved measurement in a *.pim measurement 
file.
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To return to normal touch entry mode, reboot the instrument (turn power Off and then On). If 
your touch screen has been damaged, then refer to Section 1-2 “Instrument Description” 
on page 1-3.
 

2-13 Parameter Setting
Pop-up list boxes or edit boxes are used to provide selection lists and selection editors. Scroll 
through a list of items or parameters with the Arrow keys or by using the touch screen. Select 
numerical values by scrolling with the Arrow keys or by entering the digits directly from the 
number keypad. These list boxes and edit boxes frequently display a range of possible values 
or limits for possible values.

Finalize the input by pressing the Enter key. At any time before finalizing the input, press the 
escape (Esc) key to abort the change and retain the previously existing setting.

Figure 2-18. Arrow Navigation Mode
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2-14 Symbols and Indicators 
The following symbols, icons, and indicators convey the instrument status or condition on the 
display. The colors shown here are in the standard or default display mode. 

The battery symbol above the display indicates the charge remaining in the battery. The 
colored section inside the symbol changes size and color with the charge level. The Battery 
Charge LED (adjacent to the On/Off button) flashes when the battery is charging, and 
remains on steady when the battery is fully charged. 

Touch the storage icon to open the touch screen keyboard for saving measurements, setups, 
limit lines, or screen display JPEG files (see Figure 4-1, “Save Dialog Box” on page 4-4).

Table 2-2. Symbols and Icons

Symbol Description

Green: Battery is 30 % to 100 % charged   

Yellow: Battery is 10 % to 30 % charged

Red: Battery 0 % to 10 % charged

Green with Black Plug body: Battery is fully charged and 
external power is applied

Lightning Bolt: Battery is being charged (any color symbol)

Red Plug body: External power is applied, and no battery is 
installed, or battery has lost communications with the instrument

Storage Icon: Image of a 3.5 inch floppy disk drive, shortcut to the 
Save Menu    

Camera Icon: Saves a JPEG image of the current screen display     

Shift Key Icon: This icon is displayed between the battery symbol 
and the submenu keys after the Shift key has been pressed, and 
until another key is pressed. 
GPS Icon: This icon is displayed right after the date and time 
when GPS is available. For additional details, refer to 
Chapter 6, “GPS (Option 31)”.
Power Button with Power LED and Charge LED: This is a 
physical button with LED indicators. It is located near the number 
keypad.

Caution 
Use only Anritsu-approved batteries, adapters, and chargers with this instrument. 
Anritsu Company recommends removing the battery for long-term storage of the 
instrument.

Shift
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2-15 Soft Carrying Case
The PIM Master can be operated while in the soft carrying case by opening the front flap 
(secured by two zippers). 

The case is padded on all sides and contains protective inserts in the front and back panels. 
An additional flap at the top of the rear panel can be folded over the PIM Master top 
connector panel for additional protection.

Figure 2-19. Case Open to Operate the PIM Master
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To install the instrument into the soft carrying case:

1. The Back panel of the case is secured with two zippers that start at the bottom of each 
side. Fully close the front panel of the case to help support the shape of the case while 
you are inserting the PIM Master into the back.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Open the zippered back of the case.

4. Insert the instrument face down into the case, taking care that the connectors are 
properly situated in the case top opening. Refer to the tilting of the instrument as 
shown in Figure 2-20. Note that the instrument in this figure may differ from your 
model. The method of insertion remains the same.

5. Close the back panel and secure with one or both zippers to securely enclose the 
PIM Master.

6. Two pairs of additional straps cross over the top of the PIM Master (inside the strap 
brackets) to keep the soft case closed securely around the instrument. These straps 
have hook-and-loop fasteners. See Figure 2-22 on page 2-31.

7. An additional flap (sewn to the back cover) with a protective insert can be folded over 
the center of the top connector panel. It attaches to the front of the case by 
hook-and-loop fasteners. This flap is shown closed in Figure 2-21 on page 2-31

Figure 2-20. Putting PIM Master into Soft Case
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A side flap provides access to the side panel. Inside and below the panel is a pocket to hold a 
wireless router. The router connecting cables can be enclosed by the side flap.  

Figure 2-21. Access to Side Panel

Figure 2-22. Instrument Enclosed in the Soft Carrying Case
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2-16 Tilt Bail Stand
A tilt bail is attached to the back of the PIM Master for desktop operation. To deploy the tilt 
bail, pull the bottom of the tilt bail away from the back of the instrument. To store the tilt 
bail, push the bottom of the bail towards the back of the instrument until it attaches to the 
PIM Master. 

Figure 2-23. Tilt Bail Extended
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Chapter 3 — Quick Start Guide 

3-1 Introduction 
This chapter describes the basic setup and use of the PIM Master for performing both PIM 
and Line Sweep measurements (Option 331). Tasks common to all PIM measurements are 
introduced here.

Warning

The Anritsu PIM Master is capable of producing 80 Watts of RF power in the 
cellular communications bands. Users must take precautions to minimize 
exposure to these RF fields: 

Always terminate the PIM output port of the test equipment into a load, a 
loaded line, or a line that will radiate or absorb the energy before beginning 
a PIM test. 

Confirm that the PIM Master RF power is off after a PIM test. 

Always confirm that the PIM RF power is off before disconnecting a coaxial 
connection, otherwise RF burns may result. Immediate burns to fingers or 
eyes can result from exposure to live connectors. 

Ensure that all antennas under test are placed so that no personnel are 
exposed to RF levels that exceed the maximum allowable exposure. 
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3-2 Measurement Mode Selection
Press the Menu key and use the touch screen to select the appropriate measurement icon.

Figure 3-1.  Menu Screen with Icons for Installed Measurement Modes

Note The display of the Menu screen will vary depending on installed options.
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3-3 Cable & Antenna Analyzer Measurements (Option 331) 
Set the instrument to Cable & Antenna Analyzer mode (refer to Section 3-2 “Measurement 
Mode Selection” or “Menu Key” on page 2-22). This section is a brief introduction to cable and 
antenna analysis. For more details, refer to the Cable and Antenna Analyzer Measurement 
Guide that is listed in Appendix A. 

Select the Measurement Type

Press the Measurement main menu key and select the appropriate measurement.

Set the Frequency

1. Press the Freq/Dist main menu key.

2. Press the Start Freq submenu key and use the keypad or the arrow keys to enter the 
start frequency.

3. Press the Stop Freq submenu key and use the keypad or the arrow keys to enter the stop 
frequency.

Figure 3-2.  C&AA Measurement Menus
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Set the Amplitude

1. Press the Amplitude main menu key.

2. Press the Top submenu key and use the keypad or the arrow keys to edit the top scale 
value. Press Enter to set.

3. Press the Bottom submenu key and use the keypad or the arrow keys to edit the bottom 
scale value. Press Enter to set.

Turn on Markers

1. Press the Marker main menu key.

2. Press the Marker 1 2 3 4 5 6 submenu key and select the marker number 1 button using 
the touch screen. The underlined number on the Marker submenu key indicates the 
active marker.

3. Use the arrow keys or the keypad to move the marker. The current value for the 
selected marker is shown above the upper-left corner of the graph. It is also possible to 
drag the marker using the touch screen.

4. Delta Markers are available for each of the six reference markers. For the selected 
marker, Toggle the Delta On/Off submenu key to turn on the Delta marker.

Peak/Valley Auto Markers

When making Return Loss and VSWR measurements, the Peak/Valley Auto feature can be 
used to automatically turn on Marker 1 to peak, Marker 2 to valley, and display M1 and M2 
in the Marker Table. This feature is not available for DTF measurements.

1. Press the Marker main menu key.

2. Press the Peak/Valley Auto key.

Note
For Amplitude in Smith Chart measurements, refer to “Smith Chart” on page 2-23 
of the Cable & Antenna Measurement Guide listed in Appendix A.
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Single Limit Line

1. Press Shift and then Limit (6) to enter the Limit menu.

2. Press the Limit On/Off key to turn on the Limit.

3. Press Single Limit and then use the numeric keypad or the arrow keys to change the 
limit value and then press Enter.

4. Press the Limit Alarm key to turn on or off the Limit Alarm.

Note
Refer to the Cable & Antenna Measurement Guide listed in Appendix A for 
creating multi-segment limit lines.

Figure 3-3. Single Limit Lines

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



3-3 Cable & Antenna Analyzer Measurements (Option 331) Chapter 3 — Quick Start Guide

3-6 PN: 10580-00400  Rev. J MW82119B UG

DTF Setup

1. Press the Measurements main menu key and select DTF Return Loss or DTF VSWR.

2. Press the Freq/Dist main menu key.

3. Press the Units submenu key and select m to display distance in meters or ft to display 
distance in feet.

4. Press DTF Aid and use the touch screen, or arrow keys to navigate through all the DTF 
parameters.

a. Set Start Distance and Stop Distance. Stop Distance needs to be smaller than 
Dmax.

b. Enter the Start and Stop frequencies.

c. Press Cable, select the appropriate cable from the cable list and press Enter.

d. Press Continue.

5. Press Shift then Calibrate (2) to calibrate the instrument. Refer to “Calibrate with OSL 
Calibration” on page 3-7 for additional information. 

6. Press the Marker main menu key and set the appropriate markers.

7. Press Shift and Limit (6) to enter and set the appropriate limit lines.

8. Press Shift and File (7) to save the measurement. Refer to Chapter 4, “File 
Management” for details.

Figure 3-4. DTF Aid
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Calibrate with OSL Calibration 

1. Press the Freq/Dist main menu key and enter the appropriate frequency range

2. Press Shift then Calibrate (2) key. 

3. Select Standard or FlexCal.

4. Press Start Cal and follow instructions on screen.

5. Connect Open to RF Out and press the Enter key. 

6. Connect Short to RF Out and press the Enter key.

7. Connect Load to RF Out and press the Enter key.

8. Verify that the calibration has been properly performed by checking that the Cal Status 
message is now displaying “ON, Standard” or “ON, FlexCal”.

Note
Refer to the Cable & Antenna Measurement Guide listed in Appendix A for 
calibration details.

Figure 3-5. Calibration Setup with OSL Cal Standards 
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3-4 Passive Intermodulation (PIM) Measurements 
Set the instrument to PIM Analyzer mode (refer to “Mode Selector Menu” on page 2-21 or 
“Menu Key” on page 2-22). 

Preparing for PIM Measurements

Along with your PIM Master, you need tools and components that are provided in the 
accessory kit, and you need to set up the instrument for your planned measurements.

Checking Required Tools and Components

The following items are supplied with your PIM Master accessory kit or can be ordered 
separately as individual components. Consult your Technical Data Sheet for part numbers.

• Test cable

• Connector Saver (included with instrument, 7/16 DIN(f) to 7/16 DIN(m), 50 Ω adapter) 

• RF Adapters

• PIM Standard

• Low PIM Termination

• Torque Wrench

• Adjustable Wrench

• Cleaning Kit

Setting Up the PIM Master

1. If necessary, press the Menu key and then press the PIM Analyzer icon.

2. Before calibrating the PIM Master, set the parameters for all three measurement types. 
This will eliminate the need for recalibrating due to changing parameters. To set up the 
parameters for all three measurement modes, perform the following steps.

3. Press the Measurements main menu key and then press the PIM vs. Time submenu key.

4. Press the Freq main menu key, then select the input frequencies for the F1 and F2 
carriers, and then select the intermodulation order.

a. Press the Carrier F1 submenu key and set the desired frequency.

b. Press the Carrier F2 submenu key and set the desired frequency.

c. If necessary, press the Intermod Order submenu key until the desired setting is 
underlined (3rd, 5th, or 7th).

5. Press the Setup main menu key,

6. Set the Output Power level and Test Duration.

Note

Install the connector saver onto the PIM test port of the PIM Master using a torque 
wrench. The recommended torque is 25 N·m (~18 lbf·ft). This protects the test 
port from wearing out. Typically, 500 matings is the life of a connector for PIM 
testing. The connector saver can remain on the PIM Master while inside the soft 
case or the transit case.
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7.  Press the Setup main menu key to set the power level and test duration.

8. Press the Measurements main menu key and then press the Distance-to-PIM submenu 
key.

9. Press the Setup main menu key, then the DTP Aid submenu key.

10. On the DTP Parameters screen, use the touch screen to enter or select values for 
Distance, Data Points, and Cable type (or enter Cable Loss and Propagation Velocity).

11. Visually inspect all RF connectors on the test instrument, test lead, PIM standard, and 
Low PIM termination. Clean connections each day prior to first use. 

Note
Save your instrument settings in a setup file to allow easy recall of frequently used 
settings.
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Calibrating the PIM Analyzer  

Calibrations are temperature-dependent. A temperature deviation of approximately 
20 degrees Celsius voids an existing calibration. Two temperatures are displayed in a white 
font (in all PIM measurement modes) in the Instrument Settings Summary, just above the 
Calibration On/Off message. One is the temperature in the PIM Master now, and the other is 
the temperature in the PIM Master at calibration. 

When the current temperature (labeled now) changes ±8 °C of the calibration limit, the font 
color of the current temperature is displayed in yellow. This color changes to red if the current 
temperature exceeds the calibration limit ±10 °C from the calibration limit. N/A is displayed 
for the calibration temperature when no valid calibration file exists for the current 
instrument settings.

All calibrations are valid for an initial 12-hour limit. If the PIM Master remains On, and if all 
settings remain consistent, then the current calibration file remains effective. If any setting is 
changed after 12 hours, including a power cycle of the PIM Master (Off and On), then a 
warning is presented indicating that the current calibration is more than 12 hours old. The 
message instructs the user to verify the instrument residual PIM level and re-calibrate if 
necessary. Calibrations can be used again after settings are changed and then returned to the 
previous settings for which the calibration was performed. 

The standard calibration calibrates Distance-to-PIM, Swept PIM, PIM vs. TIME, and 
Noise Floor - Time View for the current instrument settings. A user defined calibration dialog 
is available allowing users to select specific calibrations they wish to perform, and this allows 
multiple power level calibrations to be performed at the same time. The following steps 
describe the standard calibration process.

1. Press Shift then Cal (2).

2. In the Calibration menu, press the Start Calibration submenu key.

3. Connect a PIM standard onto the test port of the PIM Master, or to the end of the PIM 
test cable, and connect a Low PIM Termination onto the PIM standard.    

4. Press Enter to calibrate or Esc to exit. 

5. During the calibration, CALIBRATION IN PROCESS... is displayed on the 
measurement screen in red letters, and a beep is emitted when this step is completed. 

6. When prompted, remove the PIM standard and the Low PIM Termination, and then 
connect only the Low PIM Termination.

7. Press Enter to calibrate or Esc to exit. 

8. If the Low PIM Termination is better than –88 dBm, then the calibration continues, as 
in Step 9.

If the Low PIM Termination just installed has high PIM, then this calibration will not 
be useful. If the measured PIM is worse than –88 dBm, then a warning is displayed. 
See Figure 3-6 on page 3-11. The displayed warning provides 3 options.

a. Verify again After you have made corrections, press this button to continue the 
calibration.

b. Bypass verification Press this button to ignore the warning and continue the 
calibration.

Caution During calibration, RF power is present, and the red RF On light is illuminated.
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c. Exit calibration Press this button to abort the current calibration.

9. During the calibration, CALIBRATION IN PROCESS... is displayed on the 
measurement screen in red letters, and a beep is emitted when this step is completed. 

10. When prompted, remove all components from the test port leaving nothing connected at 
the point of calibration (Open circuit).

11. Press Enter to calibrate or Esc to exit.

12. During the calibration, CALIBRATION IN PROCESS... is displayed on the 
measurement screen in red letters. When calibration is complete, two beeps are 
emitted, and Calibration On is displayed at the bottom of the Instrument Settings 
Summary.

Bad Load Detection Feature   

The second step of a calibration requires removal of the PIM Standard and reattachment of 
the Low PIM Termination. If the Low PIM Termination has measured PIM worse than 
–88 dBm, then the WARNING: High PIM detected dialog box is displayed (as shown in 
Figure 3-6). 

Figure 3-6. Bad Load Detection Warning
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Verifying Residual PIM   

Perform this test immediately following a calibration or when instructed to do so, such as 
when 12 hours or more have elapsed since the existing calibration was performed. Attach the 
Low PIM Termination to the Test Port or to the end of the PIM test cable.

1. From the Measurements menu, press the PIM vs. Time submenu key followed by the 
Test submenu key so that Measure is underlined.

2. Lightly tap on the Low PIM Termination and flex the PIM test cable (if attached) during 
the PIM vs. Time test. The peak PIM value should be at least 10 dB below the pass/fail 
criteria for the DUT.

If the measured PIM is outside of the limit in Step 2, then you may have one of the following 
problems:

• Metal flakes inside one or more RF connectors

• Loose RF connector

• Faulty Low PIM Termination

• Worn connector saver

• Damaged PIM Test Port connector

Investigate and repair the source of any problem, and then repeat the calibration process.

Verifying the PIM Standard      

1. Connect a PIM Standard to the Test Port or to the end of the PIM test cable. 

2. Connect a Low PIM Termination to the PIM Standard.

3. From the Measurements Menu, press the PIM vs. Time submenu key, followed by the 
Test submenu key so that Measure is underlined. 

4. The peak PIM value for the PIM Standard that you are testing should be within ± 3 dB 
of the numbers shown in Table 3-1 on page 3-13. If the measured PIM is outside of the 
± 3 dB limit, contact Anritsu customer service at http://www.anritsu.com/contact-us.
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PIM Standards      

Table 3-1 provides PIM values and frequencies for two PIM Standards. The PIM values in 
this table represent PIM power for typical IM3 at 2 X 20 W.  

Table 3-1. PIM Value Versus Frequency for PIM Standards – with Typical IM3 at 2 X 20 W

Option F1 F2 IM3
–80 dBm at 
1775 MHz

PN: 1091-390-R

–80 dBm at 
1730 MHz

PN: 1091-446-R

700
(lower)

734 MHz 757 MHz 711 MHz
–87 dBm

–130 dBc

–87 dBm

–130 dBc

700
(upper)

734 MHz 757 MHz 780 MHz
–86 dBm

–129 dBc

–90 dBm

–133 dBc

701, 702
(lower)

768 MHz 803 MHz 733 MHz
–87 dBm

–130 dBc

–88 dBm

–131 dBc

701, 702
(upper)

768 MHz 803 MHz 838 MHz
–86 dBm

–129 dBc

–89 dBm

–132 dBc

850 869 MHz 894 MHz 844 MHz
–86 dBm

–129 dBc

–85 dBm

–128 dBc

800 791 MHz 821 MHz 851 MHz
–86 dBm

–129 dBc

–90 dBm

–133 dBc

900, 902 935 MHz 960 MHz 910 MHz
–86 dBm

–129 dBc

–85 dBm

–128 dBc

180 1805 MHz 1880 MHz 1730 MHz
–80 dBm

–123 dBc

–80 dBm

–123 dBc

194
(PCS/AWS)

1930 MHz 2130 MHz 1730 MHz
–80 dBm

–123 dBc

–80 dBm

–123 dBc

194
(PCS)

1930 MHz 1990 MHz 1870 MHz
–78 dBm

–121 dBc

–78 dBm

–121 dBc

210 2110 MHz 2170 MHz 2050 MHz
–78 dBm

–121 dBc

–77 dBm

–120 dBc

260 2620 MHz 2690 MHz 2550 MHz
–75 dBm

–118 dBc

–73 dBm

–116 dBc

Note
Typical values are shown. PIM Standards can vary ± 3 dB due to manufacturing 
variation. Record the starting value of your PIM Standard, and use that value for 
test equipment verification.
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Verifying the PIM Test Cable      

If calibration was performed on the instrument test port, then you must next verify the PIM 
performance of the test cable.

1. Connect a test cable to the PIM Master and terminate the other end with a Low PIM 
Termination. 

2. From the Measurements Menu, press the PIM vs. Time submenu key followed by the 
Test submenu key so that Measure is underlined. 

3. During the test, flex the test cable and verify that the PIM level of the test cable and the 
Low PIM Termination are at least 10 dB below the pass / fail criteria for the DUT. 

If the test cable fails, inspect the connections to ensure that they are clean and tight. If 
poor performance persists, then repeat the calibration process.

4. If the PIM level of the setup is within specification, then disconnect the Low PIM 
Termination and connect the test cable to the DUT for a PIM measurement.

Checking for External Interference   

Before performing a PIM test on an antenna system, verify that external interference is not 
present at the selected IM frequency. 

1. Connect a test cable from the PIM Master to the DUT. 

2. Press the Measurements main menu key and then press Noise Floor to open the Noise 
Floor submenu.

3. From the Noise Floor submenu, press the Test submenu key so that Measure is 
underlined. This will perform a Noise Floor - Time View measurement.

4. Verify that the external noise level at the selected IM frequency is below the required 
system pass / fail threshold for PIM. 

5. If high nose is detected, press the Noise Floor Spectrum View submenu key. If a 
calibration has not already been performed for this feature, press the Start Cal 
Spectrum View submenu key and follow the on-screen instructions.

6. Press the Test submenu key so that Measure is underlined. This will perform a 
swept noise floor measurement to help identify which frequencies in the uplink band 
are clear of interference. Marker 2 automatically shows the location of the current 
IM frequency.

Note

When testing, cables are connected and disconnected many times. In order to 
save wear on the PIM test port cables and adapters, Anritsu recommends 
removing the o-rings. This allows getting a sufficiently tight connection without 
unnecessary stress on the connectors. In the field, o-rings are important to 
maintain connection integrity over long time periods. Connections must be torqued 
to specifications in order to ensure that they prevent water intrusion.

During your test, if the DUT connector has an o-ring, leave it in place and tighten 
to the correct torque.
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Making PIM Measurements 

1. Press the Measurements main menu key and then press one of the measurement 
submenu keys (PIM vs. Time or Swept PIM).

2. From the Measurements menu, press the Test submenu key so that Measure is 
underlined.

3. During the test, tap connectors and the antenna. 

Note: Set the test duration time so that you can tap all desired areas.

4. After the measurement is complete, press the Save Measurement submenu key, provide 
an appropriate name, and save the measurement. (Refer to Section 4-3 “File 
Management” on page 4-3.)  

Measurement Types 

From the measurements menu, you can select four measurement types:

PIM versus Time 

This measurement tracks instantaneous PIM and also records Peak PIM levels throughout a 
fixed frequency PIM test. It is useful for dynamic PIM tests and provides a visual indication 
of the stability of the system under test.

Noise Floor 

Two different Noise Floor measurements are available to evaluate Rx interferers before 
making a PIM measurement. For each measurement, Tx power is Off. The Time View allows 
you to check for external interference at the IM frequency that is being measured. The 
Spectrum View allows you to view interference levels across the current Rx frequency range.

The IM products of interest are in the same frequency range that is used by mobile user 
equipment to communicate with the base station. It is therefore possible for nearby mobile 
equipment to generate signals that are high enough to interfere with your PIM measurement.

Note

The PIM Master continually monitors Return Loss at the two PIM test frequencies 
while performing a PIM test. If the Return Loss exceeds –6 dB, then the PIM test 
will be terminated, and a warning message will appear saying, “Warning! High 
Reflection from measurement path!”

If this message appears, use a DTF measurement (using Option 331 or a 
Site Master) to identify the location of the high reflections.

An option exists to by-pass the high reflection warning and continue testing into a 
high return loss system. The PIM value measured may not be accurate when high 
reflections are present. This option should be exercised by experienced users for 
troubleshooting only.
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Distance-to-PIM 

Distance-to-PIM (DTP) is similar to Distance-to-Fault (DTF), which Anritsu introduced in the 
Site Master for identifying the location of impedance mismatches in a feed line. DTP quickly 
and accurately identifies the location of PIM faults inside the feed system as well as beyond 
the antenna.

Distance-to-PIM is a swept measurement that enables identification of the location of 
multiple PIM sources in the RF path. Distance-to-PIM is an analysis feature only, and it 
should not be used as a pass / fail test.

Swept PIM 

PIM measurements are the vector sum of all PIM signals that are generated on a line at the 
IM frequency being tested. When multiple PIM sources exist, it is possible for the signals to 
combine out of phase at a particular test frequency to indicate a passing result when the 
individual PIM levels are actually failures. A Swept PIM test varies the IM frequency over a 
range of frequencies to provide you with a clearer picture of the true PIM performance of the 
system.

Adding a Limit Line  

1. Press the Shift key and then the Limit (6) key. 

2. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or 
Lower. 

3. Activate the selected limit line by pressing the On Off submenu key so that On is 
underlined.

4. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

5. Press the Amplitude submenu key to set the Limit value. 

6. Press the Limit Alarm submenu key to toggle the alarm setting On and Off. The current 
setting is underlined.

Although the instantaneous PIM values may be displayed in white numerals at the end of a 
measurement, if the measured PIM value exceeded the upper limit setting at any time during 
the measurement, then the Peak PIM values will remain displayed with red numerals when 
the measurement is complete. 

Note The upper limit must be On in order to use the Limit Alarm or the Pass Indicator.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Chapter 3 — Quick Start Guide 3-5 Setting Up Markers

MW82119B UG PN: 10580-00400  Rev. J 3-17

3-5 Setting Up Markers 
Press the Marker main menu key to display the Marker menu.

Selecting, Activating, and Placing a Marker

1. Press the Marker 1 2 3 4 5 6 submenu key and then select the desired marker using 
the touch screen marker buttons. The selected marker is underlined on the Marker 
submenu key. 

2. Press the On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the arrow keys to place the marker on the desired frequency. You can also move a 
marker on the touch screen.

4. Repeat Step 1 through Step 3 to activate and move additional markers.

Selecting, Activating, and Placing a Delta Marker:

1. Press the Marker 1 2 3 4 5 6 submenu key and select the desired marker (to become a 
delta marker). The selected marker is underlined.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 
displayed in red and ready to be moved.

3. Use the arrow keys to place the delta marker on the desired frequency.

4. Repeat Step 1 through Step 3 to activate and move additional delta markers.

Viewing Marker Data in a Table Format

1. Press the More submenu key.

2. Press the Marker Table On Off submenu key so that On is underlined. All marker and 
delta marker data are displayed in a table under the measurement graph.

3-6 Saving Measurements
1. Press the Save Measurement submenu key.

2. Press the Change Save Location submenu key and set the current location to be the USB 
flash drive or internal memory, and then press Set Location.

3. Press Change Type (Setup/JPG/…) and select Measurement. Then press the 
JPEG Capture submenu key (to select Full or Graph Only), if desired. Then press Enter.

4. Enter the file name using the touch keyboard (and Quick Name Matrix, if desired) and 
press Enter (touch screen or hard key). 

Refer to Chapter 4, “File Management” for additional file management information.

Note
After the Save Location and File Type are changed, these settings will remain in 
effect until manually changed again.
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Chapter 4 — File Management

4-1 Introduction
This chapter describes the file management features of the PIM Master and the file 
management menus. The submenus under the File menu allow you to save, recall, copy, and 
delete files in the internal memory or in an external USB flash drive. Files can also be 
managed using an external PC running Line Sweep Tools (LST).

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



4-2 Managing Files Chapter 4 — File Management

4-2 PN: 10580-00400  Rev. J MW82119B UG

4-2 Managing Files 
Press the Shift key then the File (7) key on the number keypad to display the File menu. The 
following steps describe file management.

File Types  

In the Save, Recall, Copy, and Delete menus, a submenu key is used to select the type of files 
to be managed. The Change Type Setup/JPEG/... and File Type_ALL submenu keys open the 
Select File Type list box, which displays all of the file types that can be selected in the current 
instrument mode.

The Select File Type list box may contain some of the following entries:

• ALL (displays all file types)

• Setup, *.stp 

(Setup files contain basic instrument information, measurement mode setup details 
(including calibration data), measurement marker data, and limit data.)

• PIM Measurement, *.pim 

(Measurement files contain all of the measurement data and all of the information in 
the setup files.)

• JPEG, *.jpg 

• Limit Lines, *.lim 

(The Limit line file contains limit line data details. The Limit function is available only 
in PIM versus Time and Swept PIM measurements.)

• C&AA Measurement (with Option 331), *.dat and *.vna 

You can also use the touch screen to open the drop down list for the Filetype entry box, as 
shown in Figure 4-1 on page 4-4, Figure 4-4 on page 4-7, Figure 4-5 on page 4-9, and 
Figure 4-6 on page 4-10.

File types *.map and *.kml (for two-dimensional and three-dimensional map functions) 
are not use by the PIM Master.

Note
When navigating through the File menu, pressing the Esc key returns the menu 
display to the previous menu.

Note

Traces saved as DAT can be viewed, edited, and analyzed with Handheld 
Software Tools. If the DUAL measurement display is turned on, then files are 
saved as Filename and Filename_2.

All data point formats are supported by the DAT file format, but LST must be used 
to open DAT files with 1102 data points or 2204 data points. Only with LST are 
Smith Chart and 1-Port Phase measurements supported with DAT file format. 

DAT and VNA files can be recalled only in C&AA mode, except for DTF-RL 
measurements, which can be viewed in PIM DTP mode with the Load DTF Trace 
command.
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4-3 File Management 
You can Save, Recall, Copy, and Delete files, starting from the File menu. 

Saving Files

The submenu keys that are available for file management may vary with instrument options 
and analyzer modes.

Set the Save Location 

Press the Save submenu key then the Change Save Location key and select the location to 
save files (refer to “Save Location Menu” on page 4-14). You can save files to the internal 
memory or to an external USB flash drive. You can also create new folders. If an external 
USB flash drive is connected or disconnected, press Refresh Directories to update the location 
tree. Press the Set Location submenu key to store the save location.

Save a Measurement As

The Save Measurement As submenu key is used to quickly save measurements with a specific 
filename. The PIM Master saves the measurement with the latest filename that was used to 
save a measurement and with a number that is automatically incremented and appended to 
the end of the filename. For instance, if the last measurement was saved with the name 
ACPR, pressing Save Measurement As saves the next measurement as ACPR_#1, ACPR_#2, 
and so forth. The filename that is used can be changed by using the Save dialog box 
(Figure 4-1).

Save a Measurement

Press the Save Measurement submenu key and enter the name for the measurement file. The 
file type defaults to measurement, and the appropriate extension is added based on the 
current measurement mode. For more information about file types, refer to “File Types” 
on page 4-2. Saving and recalling measurements provides a convenient reference for 
comparing site conditions at subsequent visits.

Save a Setup 

Press the Save submenu key, type a name for the setup file, confirm that the file type is Setup 
by using the Change Type submenu key or the touch screen, and then press Enter to save. 

Saving and recalling setups allows you to run the same tests again and again at different 
sites. 

Create a Menu Shortcut for a Setup file 

Press the Recall submenu key to display saved setup files. Locate the setup file to be the 
shortcut and then press and hold on the filename (on the touch screen) for a few seconds. 
Select a location in the shortcut grid to save the setup file. The shortcut grid is for the touch 
screen shortcut buttons that are displayed by pressing the Menu key.

Note A setup also can be saved and recalled from the Preset menu.
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Save a Measurement Screen as JPEG 

Press the Save submenu key, type a name for the JPEG file, confirm that the file type is 
JPEG, and press Enter to save.

Save Dialog Box  

The save dialog box (Figure 4-1) is used to store files on the internal memory or on an 
external flash drive. The file type, filename, and save location are set at this display. Refer to 
“Save Menu” on page 4-13 and “Save Location Menu” on page 4-14 for details. 

Figure 4-1. Save Dialog Box
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Quick Name Keys 

Quick Name keys, displayed below the keyboard in Figure 4-1, allow you to enter quick 
names or name parts for frequently used file names. 

Editing Quick Names 

To edit the keys, press the Shift key, then the File (7) key. Press Save, then press the Change 
Quick Name key. Select one of the Quick Names for editing, press Enter, and type in the new 
name for the key. This is the text that will be inserted into the Filename edit box. Press Enter 
again and the new name is displayed on the key. 

Figure 4-2. Select Quick Name Dialog Box
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Using the Quick Name Matrix  

From the Save dialog box (Figure 4-1 on page 4-4), press the Quick Name Matrix key (to the 
right of the Space key) to display the Quick Name Matrix dialog box. 

Press any key in the matrix to add text to the Filename. As noted under the matrix of keys, 
you can press and hold a key to change its text, which is shown on its label. The maximum 
numbers of characters is 18 per key. When the filename is complete, press the Enter key 
(either in the Matrix or above the number keypad).

To return to the Save keyboard, press the Keyboard key in the top row. You can then continue 
typing in the filename edit box. You can use the instrument Left and Right Arrow keys (above 
the number keypad) to scroll through the filename for editing. 

Recalling Files 

The recall menu enables you to view all the Measurement and Setup files in the internal 
memory and the external USB flash drive.

Figure 4-3. Quick Name Matrix Dialog Box

Note
Entries that you make for the Quick Name Matrix and Quick Name keys can be 
saved and recalled by using Setup files. 

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Chapter 4 — File Management 4-3 File Management

MW82119B UG PN: 10580-00400  Rev. J 4-7

You can sort files in the recall menu by name, date, or type. You can also choose to view only 
measurement files or only setup files by pressing File Type on the Recall dialog box and by 
selecting the file type that you want to view. For more information about file types, refer to 
“File Types” on page 4-2.

Recall a PIM Measurement

From the File menu, press the Recall Measurement submenu key, select the measurement file 
(*.pim) with the touch screen or the Up/Down arrow keys, and then press Enter. 

Recall a PIM Setup

Press the Recall submenu key. Confirm that the file type is Setup or All. Select the setup file 
(*.stp) with the touch screen or the Up/Down arrow keys, and then press Enter.

Recall Dialog Box  

The Recall dialog box (Figure 4-4) allows you to open previously saved measurements and 
setups. Refer to the “Recall Menu” on page 4-17 for additional information. 

Figure 4-4. Recall Dialog Box

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



4-3 File Management Chapter 4 — File Management

4-8 PN: 10580-00400  Rev. J MW82119B UG

Copying Files 

The steps below describe copying a file from internal memory to an external USB flash drive. 
Select the files to be copied in the top window and select the destination for the files in the 
bottom window (Figure 4-5). Refer to the “Copy Menu” on page 4-19 for additional 
information.

1. Insert a USB drive into either of the USB Type A ports of the PIM Master. 

2. From the File main menu, press the Copy submenu key. The Copy submenu and Copy 
dialog box are displayed.

3. Select the files to be copied. To select multiple files, highlight the first file, then press 
the Select or De-Select key to keep the desired files selected. A selected file will be 
outlined in blue. Repeat with all the files to be copied. To display files in a folder, select 
the folder and press the Enter key.

4. Press the Scroll submenu key and highlight the USB drive in the lower window by using 
the touch screen or the Up/Down arrow keys. The Scroll submenu key toggles between 
Src (source, top window) and Dst (destination, bottom window).

To choose a subdirectory on a USB drive as the save destination, select the desired USB 
drive (with Arrow keys or with the touch screen) and press the Enter key to see 
available subdirectories. When a directory or subdirectory is highlighted, subdirectories 
can be displayed or closed by pressing the Right and Left arrow keys.
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5. Press the Copy key to copy the files to the flash drive.    

Figure 4-5. Copy Dialog Box

Note Use the Left/Right arrow keys to Collapse/Expand folders.
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Deleting Files 

Delete a Selected File or Files 

Press the Delete submenu key. Highlight the file to be deleted with the touch screen or with 
the Up/Down arrow keys. Press the Select or De-Select key to include desired files. A selected 
file will be outlined in blue. Press the Delete key and then press Enter to delete the selected 
file. 

Delete Dialog Box  

Press the Delete submenu key to open the Delete dialog box (Figure 4-6). The submenus allow 
sorting files by type, name, and saved date. Refer to the “Delete Menu” on page 4-21 for 
additional information. 

Figure 4-6. Delete Dialog Box
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4-4 File Menu Overview  
Open the File menu by pressing the Shift key, then the File (7) key. Menu maps typically 
display all possible submenu keys, although some keys are displayed on the instrument only 
under special circumstances (refer to menu descriptions on the following pages). 

Figure 4-7. File Menu Overview

File

Copy

Recall

Recall

Measurement

Recall

Save

Save Measurement As

FileName_#1.pim

Save

Measurement

Delete

Sort By

Name    Date    Type

Sort Order

Asc              Desc

File Type

Measurement

Refresh

Directories

Recall

B

A
Sort By

Name    Date    Type

Sort Order

Asc              Desc

Scroll

Scr                Dst

File Type

ALL

Refresh

Directories

Select
or

De-Select

Copy

CopyA B
Sort By

Name    Date    Type

Sort Order

Asc              Desc

File Type

ALL

Select
or

De-Select

Delete

Refresh

Directories

Delete

Sort By

Name    Date    Type

Sort Order

Asc              Desc

Create

Folder

Set

Location

Refresh

Directories

Save LocationSave

Change

Save Location

Change Type

Setup/JPEG/...

Change

Quick Name

Restore
Default Quick
Name Buttons

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



4-5 File Menu Chapter 4 — File Management

4-12 PN: 10580-00400  Rev. J MW82119B UG

4-5 File Menu  
Key Sequence: File  

Save Measurement As: Press this key to save the current setup with a 
user-defined filename. The default filename is changed using the Save 
submenu. To change the default filename, press the Save Measurement 
submenu key to open the Save dialog box. Enter the new measurement 
filename with the letter keys. Refer to “Save Menu” on page 4-13. Press 
Enter to save the name and return to the File menu. The Save 
Measurement As submenu key displays the new entered name appended 
with _#1.pim. After a few seconds, the screen returns to the File menu. 
Press the Save Measurement As key again, and the new filename will be 
used. Each press of this submenu key saves the current measurement with 
the same base filename while incrementing the final number. Measurement 
file names have a .pim extension. 

Save Measurement: Press this submenu key to display the “Save Menu” 
and the Save dialog box (see Figure 4-1 on page 4-4). Measurements can be 
saved to internal memory or to a USB flash drive. The saved measurement 
can be named using the text entry keys in the dialog box. By default, 
measurements are saved to internal memory in a directory named /user. 
The save destination is set with the “Save Location Menu” on page 4-14.

Save: Press this submenu key to display the “Save Menu” on page 4-13. 
Measurements can be saved to internal memory or to a USB flash drive. The 
saved setup, measurement, or JPEG file can be named by using the text 
entry keys in the dialog box. By default, measurements are saved to internal 
memory in a directory named /user. The save destination is set with the 
“Save Location Menu” on page 4-14.

Recall Measurement: Press this submenu key to display the “Recall Menu” 
on page 4-17. This menu is for recalling measurements from internal memory 
or from a USB flash drive.

Recall: Press this submenu key to display the “Recall Menu” on page 4-17. 
This menu is for recalling measurements or setup data from internal memory 
or from a USB flash drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-19. 
This submenu is for copying files or folders to and from internal memory and a 
USB flash drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-21 
and a selection box that shows the setup and measurement names, the file 
type, and the date and time that the information was saved. Use the Up/Down 
arrow keys or the touch screen to highlight the file that is to be deleted and 
press the Delete submenu key, then confirm your selection by pressing Yes or 
No in the dialog box. Press the Esc key at any time to cancel the operation. 
Note that deleted files cannot be recovered.

Figure 4-8. File Menu
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4-6 Save Menu 
Key Sequence: File > Save 

Save Menu

Restore Default Quick Name Buttons: Press this submenu key to restore 
all Quick Name Key and Quick Name Matrix entries to the factory default 
entries.

Change Quick Name: Press this submenu key to change the Quick Names 
at the bottom of the touch screen keyboard (see Figure 4-1 on page 4-4). 
Select the Quick Name to edit, and press Enter. Type the new Quick Name 
and press Enter again. The new Quick Name is displayed on the button 
below the keyboard.

Change Save Location: Press this submenu key to open the “Save Location 
Menu” on page 4-14. 

Change Type: Press this submenu key to open the Select File Type list box 
and display the File Type menu. 

File Type Menu

JPEG Capture
Full Graph Only: Press this submenu key to toggle between file types Full 
and Graphic Only. Choose Full to include all of the additional data on the 
measurement screen. Choose Graphic Only to capture just the 
measurement trace in the sweep window.

Figure 4-9. Save Menu
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4-7 Save Location Menu  
Key Sequence: Shift > File (7) > Save > Change Save Location 

This menu and dialog box (Figure 4-11 on page 4-15) are used to create folders and to select 
the location that the PIM Master will use to save the current file. Select folders or drives with 
the Up/Down arrow keys or the touch screen.   

Note
Only folders (not files) are visible in the Save Location dialog box. To view files, 
use the “Save Menu” on page 4-13 or the “Recall Menu” on page 4-17.

Sort By
Name Date Type: Press this submenu key to sort the folders by Name, 
Date, or Type. 

Sort Order
Asc Desc: Display the folder names in ascending or descending order.

Create Folder: Press this submenu key to create a new folder in the 
highlighted location or folder. The create directory dialog box is displayed for 
naming the folder. See Figure 4-12 on page 4-16.

Set Location: Press this submenu key to set the current location for saving 
files and to return to the “Save Menu” on page 4-13.

Refresh Directories: Press this submenu key to update the display.

Figure 4-10. Save Location Menu
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Select Save Location Dialog Box   

Figure 4-11. Select Save Location Dialog Box
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Create Directory Dialog Box   

Figure 4-12. Create Directory Dialog Box
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4-8 Recall Menu  
This menu and the dialog box shown in Figure 4-14 on page 4-18 are used to navigate folders 
and select files to be recalled to the PIM Master. Select folders or files with the Up/Down 
arrow keys or the touch screen.

Key Sequence: Shift > File (7) > Recall 

File Types in the list box include Map, KML 2D, and KML 3D, which are not use by the 
PIM Master.

Use these menu keys to change the way files are listed in the Recall dialog 
box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced by 
the stored setup information. When recalling a saved measurement and 
multiple traces are displayed, parameter settings shown on the instrument 
screen may reflect those of the recalled trace or the active trace, depending 
on the measurement mode or other factors.:

Sort By
Name Date Type: Press this submenu key to sort file and folders by the 
file name, by the date that the file or folder was saved, or by the type of file.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending or descending order based on the selection in the Sort By key.

File Type: Press this submenu key to open the Select File Type list box and 
select the type of file to be viewed. The file type can be changed with the 
Up/Down arrow keys. Press Enter to make the selection. Some examples of 
file types are:

Setup: Setup files contain basic instrument information, measurement 
mode setup details, measurement marker data, and limit data. 

Measurement: Measurement files contain all of the information in the 
setup files and the measurement data.

Limit Lines (.lim): The Limit line file contains limit line data details. (The 
Limit function is available only in PIM versus Time and Swept PIM 
measurements.)

ALL: Displays all file types.

For more information about file types, refer to “File Types” on page 4-2.

Refresh Directories: Press this submenu key to update the display.

Figure 4-13. Recall Menu
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Recall Dialog Box  

Select folders or files with the Up/Down arrow keys or the touch screen. 

Figure 4-14. Recall Dialog Box
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4-9 Copy Menu 
This menu and dialog box are used to copy folders and files. Select folders or files with the 
Up/Down arrow keys or the touch screen. Figure 4-16 on page 4-20 shows the Copy dialog box 
with two JPEG images selected and ready to be copied to the USB flash drive. Highlight a 
folder and then press either Enter or the Right arrow key to view the contents.

Key Sequence: File > Copy 

Sort By
Name Date Type: Press this submenu key to sort file and folder lists 
by name, by type of file, or by the date that the file was saved.

Sort Order
Asc Desc: Press this submenu key to display the folders or files in 
ascending (Asc) or descending (Desc) order based on the selection in the 
Sort By key.

File Type: Press this submenu key to select the type of files to view for 
copying. The file type can be changed with the Up/Down arrow keys or by 
using the touch screen. Press Enter to make the selection.

For more information about file types, refer to “File Types” on page 4-2.

Refresh Directories: Press this key to update the display. 

Scroll
Src Dst: Press this submenu key to use the scroll function in either the 
Source Window (Scr - top pane) or the Destination Window (Dst - bottom 
pane). See Figure 4-16.

Select or De-Select: Use this key to select or deselect the files or folders to 
be copied. When selected, a file or folder is highlighted in blue (see 
Figure 4-16). 

Copy: Press this submenu key to copy the files or folders that are selected 
in the top pane to the destination that is selected in the bottom pane. A 
dialog box is displayed when the copy function is complete. If a file with the 
same name exists in the destination folder, then a warning box is displayed 
to allow file overwrite or to allow cancel.

Figure 4-15. Copy Menu
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Copy Dialog Box   

Figure 4-16. Copy Dialog Box
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4-10 Delete Menu  
Key Sequence: Shift > File (7) > Delete 

See Figure 4-6 on page 4-10 for an illustration of the Delete dialog box.

This menu and dialog box is used to delete folders and files. Select folders or 
files with the Up/Down arrow keys. 

Sort By
Name Date Type: Press this submenu key to sort files and folders 
by name, by the type of file, or by the date that the file or folder was saved.

Sort Order
Asc Desc: Displays the folder or file in ascending or descending order 
based on the selection in the Sort By key.

File Type: Press this submenu key to select what type of file view for 
deleting. The options are ALL, Measurement, Setup, Limit Lines, or JPEG. 
The file type can be changed with the Up/Down arrow keys. Press Enter to 
make the selection.

For more information about file types, refer to “File Types” on page 4-2.

Select or De-Select: Use this key to select or deselect the file(s) or 
folder(s) to be deleted. When selected, a file or folder will be outlined in blue.

Delete: Press this key to open the Delete dialog box (Figure 4-16 
on page 4-20). Press Enter to delete the selected item or Esc to Cancel. 

Refresh Directories: Press this key to update the display.

Figure 4-17. Delete Menu
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Chapter 5 — System Operation

5-1 Introduction
This chapter describes PIM Master system operations. Other menus are described in the PIM 
analyzer measurement chapters.

5-2 System Menu Overview   
To access the functions under the System menu, press the Shift key, then the System (8) key. 
Figure 5-1 show the menu group that is accessible from the System menu. Menu maps 
typically display all possible submenu keys, although some keys are displayed on the 
instruments only under special circumstances (refer to the menu descriptions on the following 
pages).
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System Menu Map 

Menu maps typically display all possible submenu keys, although some keys are displayed on 
the instrument only under special circumstances (refer to menu descriptions on the following 
pages). 

Figure 5-1. System Menu Map

GPS

Back

GPS

On               Off

GPS Voltage

3.3 V             5 V

GPS Info

Reset

System

System

Options

Application

Options

GPS

Status

Self

Test

Application
Self
Test

Calibrate
Touch
Screen

Back

Display Settings

Brightness

Default Colors

Black on White

Night Vision

High Contrast

Display Blank

Color on White

1

2Reset

System Options

Date
&

Time

Language

Name

Volume

Ethernet

Config

Display

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fouth Octet

12

Back

Reset

Factory

Defaults

Master

Reset

Update

Firmware

3

Back

Brightness Settings

Brightness

Auto Dim
Delay (min)

10

Auto Dim
Brightness
20.00 %

Auto Dim

On            Off

3

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Chapter 5 — System Operation 5-3 System Menu

MW82119B UG PN: 10580-00400  Rev. J 5-3

5-3 System Menu        
Key Sequence: Shift > System (8) 

Status: Press this submenu key to display the current system status, 
including the operating system and firmware versions, temperatures, and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.

Self Test: Press this submenu key to run a series of tests that are related to 
the performance of the motherboard hardware. Press the Esc key to abort, or 
press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. 

If the Self Test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, contact your Anritsu Service 
Center (refer to “Contacting Anritsu for Sales and Service” on page 1-2) and 
report the test results. Press Esc or Enter to return to normal operation.

Application Self Test: Press this submenu key to run a series of tests that 
are related to the performance of the instrument hardware and that are 
specific to the current instrument application (refer to 
Section 2-9 “Mode Selector Menu” on page 2-21). Press the Esc key to abort, 
or press the Enter key to continue. The display lists a summary of those tests 
that have passed. If any test fails, then all of the performed tests are listed 
with Pass/Fail notification. If any test fails, contact your Anritsu Service Center 
and report the test results.

Some of the hardware that is tested may also be used in different operating 
modes. One or more additional submenu keys may be displayed to allow 
running additional application self tests. 

GPS: Press this submenu key to open the GPS Menu. Refer to 
Chapter 6, “GPS (Option 31)” for additional information. This submenu key is 
displayed only when Option 31 is installed.

Calibrate Touch Screen: Press this submenu key to begin touch screen 
calibration. Additional details and related features are described in 
Section 2-12 “Touch Screen Calibration” on page 2-26.

Application Options: Submenu keys are specific to each measurement 
mode. No menu options are available for PIM Analyzer modes. For other 
modes, please refer to a specific Measurement Guide, as listed in 
Appendix A.

System Options: Press this submenu key to open the “System Options 
Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu   

Key Sequence: Shift > System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys to 
select the date and time. Press Enter to accept the changes, or press the Esc 
key to return to normal operation without changing anything.

Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box to set the IP address of the 
instrument. For details, refer to section “Ethernet Configuration” on page F-1 
in Appendix F, “LAN and DHCP”. 

Language: Press this submenu key to open a list box and select a built-in 
language for the PIM Master displays. The languages that are currently 
available are: English, French, German, Spanish, Japanese, Chinese, 
Korean, Italian, and Russian. In addition, a custom language may be selected 
if it has been defined by using Line Sweep Tools and loaded into the 
PIM Master. Two custom languages may be loaded into the instrument via 
Line Sweep Tools. If a mode does not have language translations available, 
then English is the default language. Press Enter to accept the change, or 
press the Esc key to return to normal operation without changes.

In addition, any existing language (except English) may be edited for a better 
local translation.

Caution: A reset will overwrite any custom settings within the 
PIM Master and will require that you reload the custom language files 
via Line Sweep Tools.

Display: The Display submenu key opens the “Display Settings Menu” 
on page 5-5 allowing brightness control and the selection of different display 
attributes.

Name: Press this submenu key to open a dialog box to name the instrument. 
The PIM Master can be named by using the text entry keys, which are similar 
to those shown in Figure 4-1 on page 4-4. Press Enter to save the name.

Volume: Press this submenu key to set the speaker volume. The current 
volume setting is displayed on the screen. Use the keypad, the Up/Down 
arrow keys to change the volume, and press the Enter key to accept the 
change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-7.

Figure 5-3. System Options Menu
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Display Settings Menu  

Key Sequence: Shift > System (8) > System Options > Display 

Brightness: Press this submenu key to display the “Brightness Settings 
Menu” on page 5-6. 

Display Blank: Opens a note box. Press Enter to turn off the display, or 
press Esc to abort. When the display is off, turn on the display with three rapid 
key presses of any key except the power key (or turn instrument power Off 
and On).

Default Colors: Sets the display colors to their factory default condition and 
is used for normal viewing. The measurement grid is black (or a shade of 
gray), and the background is black.

Black on White: Sets the display colors to black (data) and white 
(background). This setting is used for printing and viewing in broad daylight 
conditions.

Night Vision: Sets the display to a red-tinted color (data) with a black 
background. Optimized for night-time viewing.

High Contrast: Increases the black and white contrast of the default display. 
This setting is used for challenging viewing conditions.

Color on White: Sets the display background to white, the grid to gray, and 
leaves sweep data in color. This setting is used for printing and viewing in 
broad daylight conditions.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-4. Display Settings Menu
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Brightness Settings Menu  

Key Sequence: Shift > System (8) > System Options > Display > Brightness  

Brightness: The brightness of the display can be adjusted to optimize 
viewing under a wide variety of lighting conditions. Use the Up/Down arrow 
keys (increment changes of 25), the Left/Right arrow keys (0 or 100) to 
select a brightness level from 0 to 100, with 100 being the brightest. Press 
Enter to accept the change. All of the visible display options are affected by 
the Brightness setting.

Auto DIM
On Off: In order to extend battery life, the PIM Master can be configured to 
automatically dim the screen to a lower brightness setting after a specified 
amount of inactive time. Setting Auto DIM to ON enables this feature, and 
setting Auto DIM to OFF disables this feature. The Auto DIM feature is also 
disabled while the PIM Master is connected to a DC power source. To revive 
the screen to the default brightness setting, touch the touch screen or press 
any number key.

Auto Dim Delay (min): Sets the amount of time to wait after the last screen 
touch or number key entry before dimming the screen. This value can be set 
between 1 minute and 15 minutes.

Auto DIM Brightness: Sets the brightness level to which the instrument can 
dim (0 % to 25 %). The lower the brightness level, the more the gain in battery 
life.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-5. Display Settings Menu
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Reset Menu  

Key Sequence: Shift > System (8) > System Options > Reset    

 

Factory Defaults: Press this key to restore the instrument to the default 
settings for all measurement modes and system settings, including 
connectivity, language, and the display and audio settings. The instrument will 
power cycle when the operation is complete. Press the Enter key to initiate 
the reset, or press Esc to abort.

Master Reset: Press this submenu key to restore the instrument to factory 
defaults as described above and to delete all user files from the instrument 
internal memory. The instrument will power cycle when the operation is 
complete. Press Enter to initiate the reset, or press Esc to abort.

Update Firmware: Press this submenu key to update the instrument 
operating system using an external USB drive. Press Enter to begin the 
update, or press Esc to return to normal operation without updating. Refer to 
Section E-5 “PIM Master Firmware Update” on page E-6 for additional 
information.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-6. Reset Menu
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5-4 Preset Menu  
Key Sequence: Shift > Preset (1) 

5-5 Self Test  
At power on, the PIM Master runs through a series of quick checks to ensure that the system 
is functioning properly. The System Self Test runs a series of tests that are related to the 
instrument hardware. The Application Self Test runs a series of tests that are related to the 
instrument hardware that is used in the current operating mode of the instrument. 

If the PIM Master is within the specified operating range with a charged battery and the self 
test fails, contact your Anritsu Service Center. 

To initiate a self test when the system is already powered up:

1. Press the Shift key and then the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed. 

Press the Esc key to continue.

Also refer to Self Test and Application Self Test in the “System Menu” on page 5-3.

Preset: This key resets all parameter settings for the current measurement 
mode to their factory default values, and switches the display to the default 
view for that mode. Measurement settings specific to other modes, or 
applications, are not affected.

Save Setup: Opens the Save dialog box to name and save the current 
operating settings, allowing them to be recalled later to return the instrument 
to the state it was in at the time the setup was saved. 

Recall Setup: This key allows the selection and recall of a previously stored 
instrument setup. All current instrument settings are replaced by the stored 
setup information. 

Figure 5-7. Preset Menu
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Chapter 6 — GPS (Option 31)

6-1 Introduction   
The PIM Master MW82119B is available with a built-in GPS receiver feature (Option 31) 
that can provide latitude, longitude, altitude, and UTC timing information. When GPS is 
actively locked to satellites, this information is saved with all saved measurements and can 
be displayed with Line Sweep Tools. 

6-2 Setting Up GPS (Option 31)   
In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside without any obstructions. In addition to having 
Option 31 installed, the PIM Master requires a GPS antenna. 

Anritsu GPS antenna part numbers: 

• 2000-1528-R (with 15-foot cable) 

• 2000-1652-R (with 1-foot cable) 

• 2000-1760-R (no cable)

Activating the GPS Feature

1. Attach the GPS antenna to the GPS Antenna connector in the side connector panel (see 
Figure 2-7 on page 2-10).

2. Press the Shift key then the System (8) key on the number keypad to display the 
System menu.

3. Press the GPS submenu key to display the GPS menu.

4. Activate GPS by pressing the GPS, On/Off submenu key so that On is underlined. When 
GPS is first turned On, the GPS icon is displayed in red to indicate that less than 
3 satellites are currently being tracked. 

Figure 6-1. GPS Icon, Red
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5. Press the GPS Info submenu key to open the GPS Info window, which displays:

• Tracked Satellites

• Latitude

• Longitude

• Altitude

• UTC timing information

• Fix Available

• Alamanac Complete

• Antenna Status

• Receiver Status

• GPS Antenna current and voltage

6. When the GPS receiver is tracking at least 3 satellites, the GPS icon changes to green.   

Figure 6-2. GPS Icon, Green

Note
To reset the GPS, press the Reset submenu key. The green GPS icon with a red 
cross appears when GPS satellite tracking is lost (see Figure 6-3). 

Figure 6-3. GPS Icon, Green with Red Cross
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6-3 GPS Menu  
Key Sequence: Shift, System (8) > GPS 

GPS
On Off: Press this submenu key to turn GPS On or Off.

GPS Info: Press this submenu key to open the GPS INFO list box to display 
the current GPS information. Refer to “GPS Info” on page 6-4.

GPS Voltage
3.3 v 5 V: Press this submenu key to set the source voltage to be either 
3.3 V or 5 V, depending on the GPS receiver being used. GPS antenna 
voltage is set to 3.3 V by default in order to prevent accidental damage to 
lower-voltage GPS antennas.

Reset: This key resets the number of tracked satellites to 0 and erases any 
almanac data and saved coordinates. The process of searching for and 
reacquiring satellites will begin again.

Back: Press this key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu
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GPS Info 

Tracked Satellites: Shows the number of tracked satellites (three are required to retrieve 
latitude and longitude, four are required to resolve altitude). Generally, the larger the 
number of satellites tracked, the more accurate the GPS information.

Latitude and Longitude: Shows location in degrees, minutes, and seconds.

Altitude: Shows altitude information in meters.

Fix Available: The cold start search sets are established to ensure that at least three 
satellites are acquired within the first couple of minutes. When the three satellites are found, 
the receiver computes an initial fix (typically in less that two minutes). Fix Available: No 
means that the initial position has not been established.

Almanac Complete: The system Almanac contains information about the satellites in the 
constellation, ionospheric data, and special system messages. In a cold start, the GPS receiver 
does not have any navigation data, so the receiver does not have a current almanac. A 
complete system almanac is not required to achieve a first position fix. The availability of the 
almanac, however, can significantly reduce the time to first fix.

Antenna Status: OK and Short/Open

• OK: Antenna is connected properly and is working properly.

• Short/Open: A short or open exists between the antenna and the connection. If this 
message is displayed, then remove and reconnect the GPS antenna. If the message 
persists, then try another Anritsu GPS antenna. If the message persists, contact your 
nearest Anritsu Service Center (refer to “Contacting Anritsu for Sales and Service” 
on page 1-2).

Receiver Status: Current status of the receiver.

GPS Antenna Voltage and Current: Shows voltage and current.
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Chapter 7 — Anritsu Tool Box with 
LST

7-1 Introduction
This chapter provides a brief overview of the Anritsu Tool Box and the Line Sweep Tools 
(LST) program. For detailed information about Line Sweep Tools, refer to the program Help.

7-2 Anritsu Tool Box 
The Anritsu Tool Box is a central location to open an Anritsu measurement, visit the 
Anritsu web site, or launch an Anritsu application. The Tool Box contains software tools 
including a Line Sweep Tools program and other PC Tools for Anritsu Handheld RF 
Instruments.

The Tool Box installer is available for download from the Anritsu web site at:
http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

7-3 Install the Software
Run the Tool Box installer from the Downloads folder (if you just performed the download), 
and follow the on-screen instructions (Figure 7-1). The screens shown below are for 
illustration purposes only and may vary with the installer version.

 

Note
The figures in this user guide are provided as examples. They may not match your 
images.
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The Setup Wizard lets you choose which software Tool Box component to install. By default, 
all available Tool Box applications are selected. See Figure 7-2.  

Figure 7-1. Anritsu Software Tool Box Setup Wizard
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After the Anritsu Tool Box has been installed on the PC, either click on the shortcut icon on 
the desktop or click Start and navigate through the Programs folder to the Anritsu folder. 
Then click on the Anritsu Tool Box shortcut to open the Anritsu Tool Box. After the Tool Box 
is open, move the mouse pointer over any of the application icons to view a short description 
of the application.

7-4 Line Sweep Tools      
Line Sweep Tools is a program designed to increase productivity for people who work with 
dozens of Cable traces, Antenna traces, and Passive Intermodulation (PIM) traces every day.

Why use Line Sweep Tools?

Line Sweep Tools can:

• Collect sweeps from Anritsu PIM and Line Sweep gear.

• Help verify that those sweeps are done properly and that the Cable, Antenna, and PIM 
sweeps meet specifications.

• Help create reports of the findings, quickly and to a professional standard.

Figure 7-2. Select Tool Box Components to Install
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Line Sweep Tools Features

The Line Sweep Tools user interface is familiar to users of Hand Held Software Tools, the 
current industry standard line sweep post-capture trace processing software. This leads to a 
short learning curve and easy trace collection, validation, and reporting. 

The Anritsu Line Sweep Tools program includes:

• Presets for markers and limit lines, which take hours off the report preparation time 
for a user with dozens of traces to verify.

• The Report Generator, which makes generating PDF reports for multiple traces, with 
logos, quick and easy.

• Dual Trace viewing mode, which ensures compatibility with the E series line sweep 
instruments and with the PIM Master.

• A naming grid, which makes naming files, titles, and subtitles much quicker and error 
free.

• Line Sweep Tools can open DAT or VNA files from a wide range of current and 
supported Anritsu handheld instruments. 

• Line Sweep Tools can open the PIM files generated by Passive Inter-Modulation 
measurements.

Using Line Sweep Tools

Like its predecessor, Hand Held Software Tools (HHST), Line Sweep Tools is intuitive for 
most users. However, unlike HHST, Line Sweep Tools has the capability to work rapidly with 
a large number of traces.  

Figure 7-3. Line Sweep Tools Window
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Line Sweep Tools can open DAT files from HHST or VNA/DAT files from Anritsu 
instruments. It also can open PIM files. Files (after opening) can be inspected and modified in 
many different ways. Line Sweep Tools saves files as a new type of DAT file, and can export 
traces as VNA, text, JPG, BMP, or PNG. Line Sweep Tools produces files that can be opened 
by HHST. 

Markers and Limit Lines

The easiest way to manage markers is to turn one on and use the mouse to drag it to the 
desired position. The marker tool bar is shown in Figure 7-4. Markers number 2 and 
number 8 are On in the figure. Markers can be set to an exact value by pressing the “e” 
button, which displays detailed marker controls, numeric value entry, peak find, and valley 
find. 

The dark button on the right turns on the limit line. When On, it can be dragged to the 
desired location, or placed at an exact amplitude value by entering a number. 

Marker Presets

The fastest way to manage markers on multiple traces is to use the preset function. The 
marker and limit line preset tool bar allows users to quickly set all markers and the limit line 
to pre-defined values on similar traces (Figure 7-5). 

First set the markers and limit lines on a typical trace to the desired values. Then, press the 
red “e” (edit) button on the Preset Tool Bar. This puts the preset buttons into “learn” mode. 
Next, press a preset button (1 through 7). This programs the preset button where to put the 
markers and limit lines. Finally, press the red “e” button again to exit the learn mode. 

The programmed button is now enabled. Line Sweep Tools can program up to 7 buttons with 
preset markers and limit line. 

To use the preset, just press it, and the markers and limit line are displayed at the 
programmed locations even when switching to a new trace. The two arrow keys make going to 
the next or previous trace simple. Using presets, a dozen similar traces can be reliably 
validated in seconds.

Note Power meter mode (*.pm files) are not supported by LST.

Figure 7-4. Marker and Limit Tool Bar

Figure 7-5. Preset Tool Bar
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Naming Grid

The naming grid allows you to quickly and consistently name files, trace titles, and trace 
subtitles. The grid can be set up with custom phrases to make the naming process simpler. 

To use the naming grid:

1. Click on the left icon of the Naming Grid Tool Bar.

2. Place the cursor in the desired entry window – Filename, Title, or Subtitle.

3. Make an entry by typing the name on the keyboard or by pressing the preset label 
buttons. All button entries are appended to the name in the current entry window. 
Press the Clear Field button to clear any entries and start over.  

4. After completing entries, press OK to close the naming grid.

5. Click on the icons shown in Figure 7-6 to apply the new title, subtitle,  filename, or 
combination (when using Save As) to the current trace. 

6. If desired, use the arrow keys on the Marker Preset Tool Bar to go to the next trace.

Figure 7-6. Naming Grid and Naming Grid Tool Bar

Note Right-click on a matrix label to change the text on the button.

Naming Grid Title

Filename Subtitle
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Report Generator

To use the report generator in Line Sweep Tools, go to File menu and select Report Setup to 
determine how you want the report to appear. In the example in Figure 7-7, the report is set 
up to include the name of the contractor that did the work (Company field), the company for 
which the report is prepared, and the testing location. The report will be generated in PDF 
output format. 

When the report generator is set up, File > Generate Report creates the output PDF. The 
report will include all traces that were open (in LST) at the time the report was made. 

The following sections describe graphical and tabular report options.

Figure 7-7. Report Setup Tab
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Graphical Line Sweep Reports 

Figure 7-8 illustrates graphical line sweep reports.  

Figure 7-8. Generated Line Sweep Reports
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Graphical PIM Reports 

For PIM reports that include PIM vs. Time, Noise Floor, Distance to PIM, and Swept PIM, 
use the LST standard report generator.

1. Open all of the measurements that are intended to be in the report. 

2. Adjust limit lines, scale, markers, and titles as desired.

3. Go to File > Report Setup to specify the desired appearance of the report (See Figure 7-7 
on page 7-7). Select the desired report header fields, the signature line options, the 
output format, and the number of traces to appear on each page. Then select OK.

4. Go to File > Generate Report to create the output report. A window opens to provide you 
with the opportunity to name the report and to choose the save location. Then select 
Save.

See Figure 7-9 on page 7-10 for an example report.

Note
Open these measurements files in the order in which you want them to appear in 
the report.
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Figure 7-9 illustrates a graphical PIM report. 

Figure 7-9. Generated Graphical PIM Sweep Report
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Tabular PIM Reports 

You can generate a summary Pass/Fail PIM report in tabular format using the LST PIM 
Report Creator Feature. This report compares the peak PIM values to the limit setting for 
each PIM vs. Time measurement, and produces a Pass/Fail result. 

1. Open all of the PIM vs. Time measurements that you intended to have in the report. 

2. Adjust limit lines, scale, markers, and titles as desired.

Go to File > PIM Report Creator (see Figure 7-10) to populate the report header fields and to 
select the report measurement units (dBm or dBc). Then select OK. 

3. A window opens to provide you with the opportunity to name the report and to select the 
save location. The select Save. See Figure 7-11 on page 7-12 for a report example

Note

Only PIM vs. Time measurements that are OPEN will appear in this tabular PIM 
Report. 

Other PIM measurements and C&AA measurements will not appear in this tabular 
PIM report.

Note
Measurements will appear alphabetically in the report based on the subtitle field.  
Adjust this field as desired on each measurement to change the report order.

Figure 7-10. LST PIM Report Creator
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Figure 7-11 illustrates a tabular PIM sweep report. 

Figure 7-11. Generated Tabular PIM Sweep Report
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Appendix A — Other Documents

A-1 Introduction
This appendix provides a list of supplemental documentation for PIM Master features and 
options. These measurement guides are available as PDF files and as free downloads from the 
Anritsu Web site. To determine the PIM Analyzer firmware version in your instrument, refer 
to the submenu key description for “Status” on page 5-3.

PIM Master Options 

Related Documents 

Table A-1. Options

PIM Master Feature (Option)
Related Document 
(Part Number)

High-Accuracy Power Meter (Option 19) 
Power Meter 
Measurement Guide 
(10580-00240)

GPS (Option 31)
Chapter 6 in this 
document

Cable and Antenna Analyzer (Option 331) 
Cable and Antenna 
Analyzer Measurement 
Guide (10580-00241)

Table A-2. Related Documents

Document Description Part Number

Product Information, Compliance, and Safety Notices 10100-00065

PIM Master Product Brochure 11410-00824

Performance Specifications
PIM Master Technical Data Sheet

11410-00821

Passive Intermodulation Analyzer Measurement Guide 10580-00402

PIM Master MW82119B Programming Manual 10580-00403

PIM Master MW82119B Maintenance Manual 10580-00401

Configuring the Anritsu PIM Master for Wireless Browser Control 11410-00784

Site Master User Guide 10580-00252
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A complete suite of computer software applications are available for download:

http://www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

Additional documents are listed in the Library tab on the Anritsu product page for 
PIM Master. 

URL for MW82119B:   

http://www.anritsu.com/en-us/products-solutions/products/MW82119B.aspx 
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Appendix B — PIM Carrier Bands  

B-1 Introduction
PIM tests are conducted by transmitting two test signals, F1 and F2, into the system under 
test and then measuring intermodulation products created by those test signals that fall 
within the receive band of the system. The PIM Master transmit signals are user adjustable 
within the range shown in Table B-1.
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B-2 PIM Master Carrier Bands     

Table B-1. PIM Master Carrier Bands and Frequencies

Carrier Band

Frequency Range
Option

Number
Rx Frequency 
Range, MHzF1 F2

LTE 700 MHz
731 MHz
to
734.5 MHz 

746 MHz
to
768 MHz

MW82119B-0700
698 to 717

777 to 806

APT 700 MHz
758 MHz
to
776 MHz 

788 MHz
to
803 MHz

MW82119B-0701
710 to 748

825 to 845

APT 700 MHz
768 MHz
to
776 MHz 

788 MHz
to
807 MHz

MW82119B-0702
713 to 748

825 to 845

LTE 800 MHz
791 MHz
to
795 MHz

811.5 MHz
to
821 MHz

MW82119B-0800 832 to 862

Cellular 850 MHz
869 MHz
to
871 MHz

881.5 MHz
to
894 MHz

MW82119B-0850 824 to 849

E-GSM 900 MHz
925 MHz
to
937.5 MHz

951.5 MHz
to
960 MHz

MW82119B-0900 880 to 915

E-GSM 900 MHz
925 MHz
to
937.5 MHz

951.5 MHz
to
960 MHz

MW82119B-0902
885 to 915

1877 to 1920

DCS 1800 MHz
1805 MHz
to
1837 MHz

1857.5 MHz
to
1880 MHz

MW82119B-0180 1710 to 1785

PCS 1900 MHz
1930 MHz
to
1945 MHz

1965 MHz
to
1995 MHz

MW82119B-0194 1850 to 1910

PCS/AWS
1900/2100 MHz

1930 MHz
to
1945 MHz

2110 MHz
to
2155 MHz

MW82119B-0194 1710 to 1755

UMTS 2100 MHz
2110 MHz
to
2112.5 MHz

2130 MHz
to
2170 MHz

MW82119B-0210
1920 to 1980 (IM7)

2050 to 2090 (IM3)

LTE 2600 MHz
2620 MHz
to
2630 MHz

2650 MHz
to
2690 MHz

MW82119B-0260 2500 to 2570
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Appendix C — Wireless Remote 
Control         

C-1 Introduction 
The MW82119B PIM Master and a ZyXEL MWR102 (or equivalent) Portable Router can be 
used to remotely control your PIM test equipment from the bottom of a cellular tower using a 
Wi-Fi link. The control software is served by the PIM Master, and this allows you to remotely 
control the PIM Master from any Wi-Fi enabled device using web browser software (Chrome 
or Firefox preferred). This includes a wide range of tablets and smart phones running 
Android or iOS operating systems as well as the traditional Linux and Windows laptop and 
desktop computers.

C-2 Portable Router for Wireless Access 
An Application Note in the PIM Library on the Anritsu Web site provides details regarding 
the equipment needed, the wireless router connection information, and the details for 
controlling your PIM Master remotely.

The Application Note title is “Configuring the Anritsu PIM Master for Wireless Browser 
Control” (refer to Appendix A, “Other Documents”). 

The control software is served by the PIM Master, so the existing browser software on your 
own computing device can be used to control the PIM Master from a remote location.

Figure C-1. Controlling the PIM Master Using a Tablet Computer 

Remote Control Option
for Tower-Top Testing
Remote Control Option
for Tower-Top Testing
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C-3 Configuring the PIM Master for Wireless Browser Control 
Wi-Fi links are useful in the field, particularly when the PIM Master is on a tower, and you 
are on the ground. For wireless browser control, the PIM Master requires firmware version 
v1.15 or later. Firmware may be downloaded from the Anritsu Web site by following the links 
for “Downloads and Software” and “Handheld RF Firmware Updates”.

C-4 Using a ZyXEL MWR102 Travel Router    

The ZyXEL MWR102 Travel Router is one of many suitable travel routers. All that you need 
to wirelessly connect to your analyzer is included with the router. This includes an Ethernet 
cable, a USB cable (for powering the MWR102), and instructions for use.

This router comes pre-programmed with a password for accessing the device. This password 
can be found on a sticker placed on the reverse side of the router. Write down the password 
and SSID for the router. You will need this information to access it.

Example Router Data: 

Figure C-2. ZyXEL MWR102 Travel Router
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Connecting the Router to the PIM Master 

The router has two Ethernet ports. One is marked ‘LAN’ (colored black) and the other is 
marked ‘WAN’ (colored blue). Insert one end of the provided Ethernet cable into the black 
LAN port on the router, and insert the other end into the Ethernet port of your PIM Master.

Insert the Mini-B (small) end of the provided USB cable into the router, and insert the 
Type-A (larger) end of the cable into one of the USB ports of your PIM Master.

The router can be secured to your PIM Master chassis by using a small strip of Velcro or other 
hook-and-loop fastener.
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Configuring PIM Master for use with Router 

Configuring the MW82119B PIM Master for use with a Portable Router (such as ZyXEL 
MWR102 or equivalent). 

1. Press Shift and System (8) to display the System Menu.

2. Press the System Options submenu key, then the Ethernet Config submenu key.

3. Configure the Ethernet connection. The example IP address is 192.168.100.5 in 
Figure C-3. 

Figure C-3 is an example of the Ethernet Editor. Your information may differ. For 
example, 255.255.255.0 should be the subnet mask.

For additional configuration instructions, refer to “Ethernet Configuration” on page F-1 
in Appendix H, “LAN and DHCP”. 

4. Ensure that your wireless device (phone, tablet, laptop) is connected to the router. Then 
launch your browser. 

5. Enter the PIM Master IP address in the browser URL field, and wait while the 
connection is made.

Figure C-3. Example of Entering Ethernet IP Address 
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6. When the browser connection is complete, the initial instrument control window is 
displayed (see Figure C-4 on page C-5). This window provides instrument status 
information.

The example IP address (192.168.100.5) appears in the title bar of the instrument 
control window (as shown in Figure C-4). 

Figure C-4. Example of Browser Control Window

MW82119B
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C-5 Remote Control via a Browser 
Select the Remote Control tab of the browser control window to display a copy of the 
PIM Master measurement screen. Follow the same process on this screen as you would on the 
PIM Master itself.

A green communication activity indicator in the lower-right-hand corner indicates the 
connection status with the PIM Master. An example of the remote control screen is shown in 
Figure C-5.  

Figure C-5. Example of Browser Remote Control Window

MW82119B

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Appendix C — Wireless Remote Control C-5 Remote Control via a Browser

MW82119B UG PN: 10580-00400  Rev. J C-7

Screen Capture 

Selecting the Capture Screen tab of the browser control window saves a time-stamped screen 
shot of the instrument display, in both the PIM Master memory and the web browser. You 
can save the image, and you can also send it via e-mail from this screen.

Selecting the Capture Trace tab of the browser control window performs the same function as 
pressing the Save Measurement submenu key on the PIM Master. Enter a filename and click 
Save. 

List of Files  

The File List tab of the browser control window displays a table of the files in the PIM Master 
internal memory. 

Figure C-6. Example of Browser Saving Captured Trace

Figure C-7. Example of Browser File List Window 

MW82119B
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You can use the check boxes in the D/L Select column to download multiple files in one 
download action. A message box provides an estimated time for the download to be prepared. 
The Web page becomes unresponsive while the download package is being prepared, and then 
becomes responsive again when the download starts. The process cannot be canceled after it 
is started. If the process is interrupted, then you do not receive the requested files. Repeat 
your request. 

Using Anritsu Line Sweep Tools 

If your controlling device is a laptop computer with Anritsu Line Sweep Tools (LST) installed, 
then you can use LST to open the PIM Master measurement files directly from the Browser 
File List, and then generate site reports. Figure C-9 on page C-9 shows LST working with the 
same trace as shown in Figure C-5 on page C-6. 

Note File download is not possible with devices running an iOS operating system.

Figure C-8. Example Using LST to Open a File in Browser List 

MW82119B
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Saving Measurements 

Saving a measurement with the browser is similar to saving on the PIM Master itself. The 
Save dialog box is shown in Figure C-10 on page C-10. A saved measurement is shown in the 
Delete dialog box in Figure C-11 on page C-10. 

Figure C-9. Example of Trace in Line Sweep Tools 
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Figure C-10. Example of Save Dialog Box 

Figure C-11. Example of Delete Dialog Box 

MW82119B

MW82119B
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Password Protection 

Access via router and browser can be password protected. If your router does not have a 
password, or if you chose not to use it, then you can set a password in the browser remote 
control window by using the Device Management tab. By default, no password protection is 
set for browser access. Figure C-12 shows a password example. 

After a password has been set, you must use the password to gain access to the PIM Master. 
Figure C-13 shows the password request window. After the password has been entered, 
access to the PIM Master is open via the router to any computer device with router access 
until you log out. Use Logout in the browser tab bar to end your access.  

Figure C-12. Browser Device Management Window

Figure C-13. Browser Password Request Window 

MW82119B

MW82119B
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Instrument Name 

You can set a name for the PIM Master from the Device Management tab (Figure C-14). This 
is the same as using the System menu in the PIM Master to enter a name. An instrument 
name can be a convenient addition when creating measurement reports. 

Figure C-14. Changing the PIM Master Instrument Name 

MW82119B
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Appendix D — Instrument Messages 
and Errors

D-1 Error Messages: Stop Current Measurements 

Warning! High Reflection from measurement path!

This message occurs when the connection to the test port produces large reflections back into 
the instrument. This can compromise measurement accuracy. To fix this error, check all 
junction connections, or remove the RF connection or component that is causing the high 
reflection. The automatic Distance-to-Fault (DTF) function performed before each 
Distance-to-PIM (DTP) test mode can be used to help determine the location of the high 
reflection. An option will be presented allowing the user to continue PIM testing even in the 
presence of a high reflection. This should only be used by experienced users for 
troubleshooting purposes as the measured PIM value may not be accurate. A warning will 
appear in large letters on the screen any time that the high reflection warning has been 
by-passed.

D-2 PIM Analyzer Warning Messages 
Warning messages provide information but allow measurements to continue.

RF PLL Lock Error
REF PLL Lock Error

These indicate a potential hardware failure that could compromise measurements. If the 
failure persists, contact your Anritsu Service Center.

Invalid Parameter Entry

If an invalid F1 or F2 frequency is entered, the instrument will display a warning message 
describing the acceptable range for the frequency carrier. If the IMx frequency does not fall 
within one of these bands, then the PIM Master produces an audible tone. In addition to the 
beep, the instrument will display a message on the screen indicating the allowed IM range. 
Also, the IM Frequency text in the PIM Summary area will turn red.

PIM AMP(S) Exceeding Normal Temperature Range

The PIM Master internal amplifiers have exceeded their normal temperature range.

PIM UNIT Exceeding Normal Temperature Range

The entire PIM Master unit is beyond the normal temperature range and degradation in 
measurement or signal dropout can occur.

PIM EEPROM Error

Can not access on-board EEPROM. Measurement results may be invalid.
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IM OVERLOAD   

This is a warning message that the measured signal level is approaching the saturation limit 
of the instrument. The actual signal level may be higher than the reported signal level under 
this condition. IM Overload is displayed in PIM vs. Time and Swept PIM measurement 
modes if PIM values exceed this saturation limit.

Receiver Amplitude Low

This message can occur if signal amplitude degrades within the instrument. It can have an 
impact on overall measurement accuracy and should be an indicator to send the unit to the 
Anritsu Service Center for repair.

High PIM Detected

This is a warning message presented during calibration if a high PIM level is detected before 
the step requiring a low PIM termination to be attached.
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D-3 Operation Error Messages 
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Appendix E — Instrument Care   

E-1 Introduction
This appendix provides instructions for preventive maintenance, battery care, and firmware 
updates. 

Appendix Overview

This appendix contains the following sections:

• Section E-2 “Preventive Maintenance” on page E-1

• Section E-3 “Battery Care” on page E-2

• Section E-4 “Battery Replacement” on page E-3

• Section E-5 “PIM Master Firmware Update” on page E-6

• Section E-6 “Adding Options with a License File” on page E-9

E-2 Preventive Maintenance   
PIM Master preventive maintenance consists of cleaning the unit and inspecting and 
cleaning the RF connectors on the instrument and all RF cables. Clean the PIM Master with 
a soft, lint-free cloth slightly dampened with water, or water and a mild cleaning solution.

Clean the RF connectors and center pins with a lint-free wipe or cotton swab dampened with 
isopropyl alcohol. Use a non-metallic object (such as the wooden end of a cotton swab) to push 
the lint-free wipe into the connector RF interface to remove metal flakes. Visually inspect the 
connectors. The pins of the connectors should be unbroken and uniform in appearance. If you 
are unsure whether the connectors are undamaged, gauge the connectors to confirm that the 
dimensions are correct.

Visually inspect the test port cables. To obtain accurate readings within instrument 
specifications, test port cables must be: free of metal flakes, uniform in appearance, and not 
stretched, kinked, dented, or broken.
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E-3 Battery Care 
The PIM Master is supplied with a rechargeable battery that could potentially leak 
hazardous compounds into the environment. These hazardous compounds present a risk of 
injury or loss due to exposure. Anritsu Company recommends removing the battery for 
long-term storage of the instrument and storing the battery in a leak-proof, plastic container. 

Environmental storage requirements:

Storage Temperature Limits: –20 °C to +50 °C, Relative Humidity ≤ 80 %

The battery packs should be stored in an environment with low humidity, free from 
corrosive gas, at a recommended temperature range <20 °C. Extended exposure to 
temperatures above +40 °C could degrade battery performance and life.

Battery charging limits: 0 °C to +45 °C, Relative Humidity ≤ 80 %

The battery supplied with the PIM Master may need charging before use. Before using the 
instrument, the internal battery may be charged either in the instrument, using either the 
AC Adapter or the 12-Volt DC adapter, or separately in the optional Dual Battery Charger. 
Anritsu part numbers for these accessories are in your Technical Data Sheet/Product 
Brochure.

Use only Anritsu approved battery packs. Anritsu part numbers are in the Technical Data 
Sheet. 

Recharge the battery only in the PIM Master or in an Anritsu approved charger.

When the PIM Master or the charger is not in use, disconnect it from the power source.

Do not charge batteries for longer than 24 hours. Overcharging may shorten battery life.

If left unused, a fully charged battery will discharge itself over time.

To prevent instrument damage, Anritsu Company recommends removing the battery for 
long-term storage of the instrument.

Temperature extremes affect the ability of the battery to charge: allow the battery to cool 
down or warm up as necessary before use or charging. 

The battery can be charged and discharged hundreds of times, but it will eventually wear out.

The battery may need to be replaced when the operating time between chargings becomes 
noticeably shorter than normal.

Never use a damaged or worn out charger or battery.

Storing the battery in extreme hot or cold places will reduce the capacity and lifetime of the 
battery.
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E-4 Battery Replacement 
The battery compartment access is on the bottom of the PIM Master. 

The battery snaps into the compartment door assembly. Orientation of the battery is 
important. A diagram inside the battery door assembly and another diagram inside the 
PIM Master compartment show an image of the battery. Notice that the connector end of the 
battery is oriented away from the latch mechanism, and the battery connection openings are 
up, or away from the plate of the door assembly.

The image in the battery door assembly shows the orientation in which you should see the 
battery as you place the battery into the door assembly (see Figure E-3). Inside the 
PIM Master compartment is a reflected image of the battery (see Figure E-2) to show how the 
battery connectors align with the pins inside the compartment. As you place the battery door 
assembly into the battery compartment, the battery connectors and the reflected image 
should match, as if you were seeing the connectors reflected in a mirror.

To avoid connector pin damage, you must not press the battery downward onto the connector 
pins within the battery compartment. You must position the battery door assembly so that 
the battery connections can slide lengthwise onto the connector pins as you seat the door 
assembly against the bottom of the PIM Master. The tab on the door fits into a slot located on 
the edge of the case adjacent to the connector pins.

Figure E-1. Battery Compartment - Open
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Figure E-2. Battery Orientation Diagram Inside Battery Compartment

Figure E-3. Battery and Cover Plate
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Inserting the Battery into the Case 

Place the blank edge of the door assembly into the PIM Master first and ensure that the 
connector end of the battery is as deep into the case as possible. This is to orient the battery 
connector openings with the connection pins inside the pm.

Slide the door assembly lengthwise into the PIM Master case making sure that the tab on the 
door assembly engages with the slot in the case. Continue moving the door assembly to seat 
the battery connections. When the latch is aligned, close the door and twist the latch to lock 
the door in place. Turn the latch handle flat so that the PIM Master can sit flat when upright.

Figure E-4. Closing the Battery Cover Plate
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E-5 PIM Master Firmware Update  
Please check the Anritsu PIM Master product page for firmware upgrade procedures.

http://www.anritsu.com/en-us/products-solutions/products/MW82119B.aspx 

If further assistance is needed, contact Anritsu at http://www.anritsu.com/contact-us.

Determining the Firmware Version

To determine the current firmware version of your PIM Master, use the following procedure:

1. Press the Shift and System (8) keys to display the System menu.

2. Press the Status submenu key to display instrument status.

The Status list box displays instrument conditions and firmware versions.

3. Note the “Package Version” number and the “MINIPIM Version” number.

The latest available version of firmware can be determined by visiting the product link 
(shown above) or by visiting the “Generic Firmware Download” page.

Downloading the Firmware 

You can search the Anritsu Web site in two ways to find the firmware for your PIM Master, 
either “Generic Firmware Download” or “PIM Master Product Page Firmware Download”.

Generic Firmware Download 

1. Enter the Anritsu Web page:

http://www.anritsu.com 

2. In the upper-left corner, enter ‘firmware update’ (do not use the quotes) in the Search 
box, and then press Enter. 

3. Click the link for ‘Handheld RF Firmware Updates’ near the top of the page. 

4. On The Anritsu Tool Box page, click the Firmware Updates link for PIM Master.

5. On the Firmware for PIM Master page, click the Download Now link for Model 
MW82119B. 

6. In the table on the download page, click the green Download button. Note the file details 
in the download dialog box, which include the file size and its release date.

7. In the download dialog box, click Save and direct the download to your USB memory 
device. You can also download to your PC and copy to a USB memory device later.

PIM Master Product Page Firmware Download 

1. Navigate to the PIM Master product page: 

http://www.anritsu.com/en-us/products-solutions/products/MW82119B.aspx 

2. Click the Library tab. 

3. Scroll to the section labeled Drivers, Software Downloads.

4. Click Firmware Update for the PIM Master MW82119B. 

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          

http://www.anritsu.com/en-us/products-solutions/products/MS82119B.aspx
http://www.anritsu.com
http://www.anritsu.com/en-us/products-solutions/products/MW82119B.aspx
http://www.anritsu.com/contact-us


Appendix E — Instrument Care E-5 PIM Master Firmware Update

MW82119B UG PN: 10580-00400  Rev. J E-7

5. On the Firmware Update page, click the Download button. Note the file details in the 
download dialog box, which include the file size and its release date.

6. In the download dialog box, click Save and direct the download to your USB memory 
device. You can also download to your PC and copy to a USB memory device later.

Updating with a USB Memory Device 

The PIM Master contains a feature that allows you to update its firmware by using a USB 
memory device. First, you must load the USB memory device with the firmware (refer to 
“Downloading the Firmware” on page E-6). Anritsu recommends that you format the USB 
memory device before loading the firmware. After the firmware is loaded onto a blank USB 
memory device, follow the instructions below to update the firmware on your PIM Master. 

1. With the PIM Master off, insert the USB Memory device into the USB port and turn on 
your PIM Master. The PIM Master will recognize the new firmware in the USB device.

The USB Memory device can be inserted while the PIM Master is On, but the update 
firmware is not checked until the instrument is turned Off and then On.

2. A message is displayed to inform you that new firmware is ready for update, and you are 
asked to choose whether to update now, by pressing the Yes or the No submenu key. 
Press Yes to begin the update.

3. The Firmware Update menu is displayed, the Firmware Update dialog box (Figure E-5) 
shows “Save none” selected, and a cautionary statement is displayed regarding user 
data. Use the Arrow keys to select an option. The choices are:

a. Save none

No attempt will be made to save any user data.

b. Save user data

User data will be saved in the selected external media device. 

WARNING: If there is not enough available memory space for all user data then 
some data may be lost during the process.

c. Save and restore user data

User data will be saved in the selected external media device. The instrument 
will also attempt to restore the files to the instrument after the update.

WARNING: If there is not enough available memory space for all user data then 
some data may be lost during the process. 

Caution
Before beginning the firmware update process, connect an external power supply 
(either the AC/DC power supply or the automotive 12 VDC adapter) to your 
PIM Master. The power must remain On until the firmware update is complete.
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4. Read through each choice carefully, select the desired save mode, and then press the 
Update From USB Memory submenu key or press Enter to begin the firmware update 
process.

5. The Firmware Update message box is displayed and directs you to press ENTER to 
continue or to press ESC to abort (Figure E-6). 

6. Press Enter to begin the firmware update process. The Firmware Update dialog box 
displays the following message:

Updating firmware. Please Wait.

7. When complete, the instrument reboots.

Figure E-5. Firmware Update Menu 

Figure E-6. Firmware Update Message Box

Update Source:  USB
User Data:  Save & restore user data

Press ENTER to continue, ESC to abort

Firmware Update
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E-6 Adding Options with a License File   
The license file installation process allows you to enable instrument software options. Only 
option retrofits that do not require additional hardware or calibration are qualified for 
enabling via a license file. 

After you purchase an option, a license file is sent via e-mail or secure FTP. You copy that 
license file to a USB memory device and enable the option in your PIM Master.

First, to purchase an option, you need the PIM Master model number, serial number, and 
auxiliary serial number. Provide this to Customer Service when you place your order. When 
your purchase order is placed, Customer Service will advise you whether the option qualifies 
for enabling via a license file. If applicable, Customer Service will send you a license file via 
e-mail or secure FTP.

1. To determine the serial number, press Shift and System (8) to display the System 
menu.

2. Press the Status submenu key and find the Serial Number and Auxiliary Serial Number 
in the displayed list.

3. Contact Anritsu Customer Service to arrange purchase of the option.

To install a license file onto an instrument, you must load it onto a blank USB memory 
device. Anritsu recommends that you format the USB memory device before loading the file. 
Use the following procedure to enable an option on your PIM Master:

1. When you receive the “MW82119B xxxxxxx.license” file, where “xxxxxxx” is the 
instrument serial number, copy that file to a blank USB memory device.

2. With the PIM Master Off, place the USB memory device into the USB Interface 
(Type A). See Figure 2-7 on page 2-10 for a description of the side panel connectors.

3. Turn On the PIM Master, and the instrument proceeds with the normal boot process 
and automatically installs the license file. A message is displayed to indicate that the 
options were changed and that you must restart the PIM Master.

4. Turn Off the PIM Master, remove the USB memory device, and turn On the 
PIM Master.

5. The instrument is ready for use with the new option enabled.
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Appendix F — LAN and DHCP

F-1 Introduction 
This appendix describes network connections for the PIM Master. 

F-2 Ethernet Configuration

LAN Connection 

The RJ-45 connector is used to connect the PIM Master to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. The instrument IP address is set by pressing the Shift key, 
then the System (8) key followed by the System Options submenu key and the Ethernet Config 
submenu key. The instrument Ethernet address can be set automatically using DHCP, or 
manually by entering the desired IP address, gateway address, and subnet mask. 

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is the most common method 
of configuring a device for network use. To determine if a network is set up for DHCP, connect 
the PIM Master to the network and select DHCP protocol in the Ethernet Config menu. 

Turn the PIM Master off, and then on. If the network is set up for DHCP, then the assigned 
IP address should be displayed briefly after the power up sequence.

Note

An active Ethernet cable must be connected to the instrument before it is turned 
ON in order to enable the Ethernet port for DHCP or for a static IP address.

Depending upon local conditions, the port may remain enabled when changing 
from DHCP to static IP address, when changing from static IP address to DHCP, 
or when temporarily disconnecting the Ethernet cable.

If the port becomes disabled, then ensure that an active Ethernet cable is attached 
to the instrument before cycling the power OFF and back ON.
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To display the IP address with the instrument on, press the Shift key, then the System (8) 
key, then the System Options submenu key and the Ethernet Config submenu key. The IP 
address will be displayed as shown in Figure F-1. The image on the display panel of your 
PIM Master may differ from the image shown here. 

Figure F-1. IP Address Assigned Using DHCP
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Ethernet Config 

Press this submenu key to display the Ethernet submenu and to open the Ethernet Editor 
dialog box in order to set the IP address of the instrument. 

Figure F-2. Setting IP Address Manually
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Ethernet Menu  

Key Sequence: Shift, System (8) > System Options > Ethernet Config 

Type
Manual DHCP: Press this submenu key to select whether the address will 
be entered manually, or will be supplied automatically by a network DHCP 
server. If Manual is selected, then use the submenu keys or the Left/Right 
arrow keys to select the field that is to be modified. Use the keypad or the 
Up/Down arrow keys to enter the input. Press Enter to accept the changes, 
or press the Esc key to return to normal operation without changing anything.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet 
Protocol Property to be edited.

First Octet: Moves the cursor to the left most column of the selected IP 
properties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.

Fourth Octet: Moves the cursor to the forth column from the left of the 
selected IP properties field.

Figure F-3. Ethernet Menu

Ethernet

Type

Manual         DHCP

Field

IP     G-Way    Sub

First Octet

Second Octet

Third Octet

Fouth Octet
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F-3 DHCP 
DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses. When a DHCP server is available on the 
network, DHCP is the preferred IP address assignment mode.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the IP address in use may change from use to use. The DHCP server hands out 
IP addresses on a first come, first served basis. As soon as the device is disconnected from the 
network, the IP address that it was using becomes available to lease to the next unit that 
requests an IP address. Normally, some amount of lag time is present on the DHCP server 
end, so if the device is connected again reasonably soon, then it may end up with the same 
address. 

When a DHCP server is not available, a Static IP address can be used. A Static IP address is 
a fixed address. After being set, it will always remain the same, and care must be taken to not 
conflict with other equipment on the network.

When using a static IP address on an established network, always request the Static IP 
address from the network administrator. Randomly choosing a Static IP address on an 
established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a Static IP address:

IP Address  

This is the Static IP address on the network.

Default Gateway   

Often when a static IP address is assigned, a default gateway is also identified. If the 
default gateway is unknown, then type in the Static IP address so that the Static IP 
address and Default Gateway are the same number.

Subnet Mask   

This parameter is usually extracted from the Static IP address based on the class of the 
address and determines the destination of any broadcast messages that might be sent 
from the instrument. It can be customized if necessary. The subnet mask may also be 
provided with the Static IP address.

Example 1

In this example, a Static IP address has been chosen because no network DHCP service is 
available. The instrument is connected to the network port on the PC with a crossover 
Ethernet cable (not included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2

Default Gateway: 10.0.0.2

Subnet Mask: 255.255.0.0
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Example 2

In this example, the Static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42

Default Gateway: 153.56.100.1

Subnet Mask: 255.255.252.0

F-4 ipconfig Tool 
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network to which the PC is connected. Typing ipconfig at a 
command prompt produces a display of information about the in-use parameters of the PC 
and its network connection. Following is an example of the typical results expected: 

Y:\>ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix. : us.anritsu.com

IP Address. . . . . . . . . . . . : 172.26.202.172

Subnet Mask . . . . . . . . . . . : 255.255.252.0

Default Gateway . . . . . . . . . : 172.26.200.1

Note
The ipconfig display does not report whether the information is from a DHCP 
server or from a Static IP setup.
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F-5 Ping Tool  
Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network, and (if it is found) to 
receive a reply. Basically, the ping function sends out a request to a specific address to 
determine if a computing device is connected to the network at that address. If a valid 
connection is found, then a copy of the signal (that was sent) is returned. If a connection is not 
found, then the response is “request timed out”, which means that no reply was received from 
that IP address. 

Y:\>ping 172.26.202.172

Pinging 172.26.202.172 with 32 bytes of data:

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Ping statistics for 172.26.202.172:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milliseconds:

Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
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Appendix G — Glossary 

G-1 Introduction 
This glossary provides definitions for common RF terms that may be associated with the use 
of a PIM Master. 

G-2 Glossary Terms
3 dB rule : The 3 dB rule provides a means to estimate relative power values. A 3 

dB gain indicates that power increases to twice the power (a multiple of 
2). A 3 dB loss indicates that power decreases to half the power (a 
multiple of 1/2). A system with 40 watts of input power and a 6 dB 
insertion loss will have only 10†watts of output power (a multiple of 1/2 
for each 3 dB loss, or 1/4 of 40 watts). 

 

Adapter : A fitting that supplies a passage between two sets of equipment when 
they cannot be directly interconnected. 

 

Adaptive Array
Antenna : Adaptive array antenna is a type of advanced ’smart’ antenna 

technology that continually monitors a received signal and dynamically 
adapts signal patterns to optimize wireless system performance. The 
arrays use signal processing algorithms to adapt to user movement, to 
changes in the radio-frequency environment, and to multi-path and 
co-channel interference. 

 

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device 
that converts continuous signals to discrete digital numbers. The 
reverse operation is performed by a digital-to-analog converter (DAC). 
ADC can uniquely represent all analog input values within a specified 
total input range by a limited number of digital output codes. Refer also 
to DAC. 

 

Analog System : An Analog system uses an analog transmission method to send voice, 
video and data-using analog signals, such as electricity or sound waves, 
that are continuously variable rather than discreet units as in digital 
transmissions. Mobile analog systems include AMPS, NMT and 
ETACS. 

 

Analog
Transmission : Analog Transmission refers to signals propagated through the medium 

as continuously varying electromagnetic waves. 
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Antenna : Antenna is a device which radiates and/or receives radio signals, 
including RF, microwave, and RADAR. 

 

Antenna
beamwidth : Antenna beamwidth, also known as the half-power beamwidth, is the 

angle of an antenna pattern or beam over which the relative power is at 
or above 50% of the peak power. 

 

Antenna Directivity : Antenna directivity, also known as antenna gain, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Directivity is the percentage of 
radiated signal transmitted or received in a given direction related to 
beamwidth. 

 

Antenna Efficiency : Antenna Efficiency is the percentage of theoretical gain actually 
realized from an antenna. 

 

Antenna Gain : Antenna gain, also known as antenna directivity, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Gain is the effectiveness of a 
directional antenna expressed as the ratio of input power of the 
directional antenna to input power of an isotropic radiator to provide 
the same field strength in the desired direction. Sometimes related to a 
dipole antenna. 

 

Antenna, Isotropic : An isotropic antenna is a theoretical point source radiating a spherical 
power envelope. 

 

Antenna, Parabolic : A parabolic antenna is an antenna utilizing a reflector that is shaped as 
a paraboloid in order to both concentrate the radiated signal into a 
beam and to provide considerable gain. Beamwidth varies inversely and 
gain varies directly with the size of the antenna and with frequency. 

 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 
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Average power : Average power is the peak power averaged over time and is usually 
applied to pulsed systems where the carrier power is switched on and 
off. 

 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

 

Bandwidth : Bandwidth usually identifies the capacity of a circuit or amount of data 
that can be sent through a given circuit. It may be user-specified in a 
PVC. It is an indication of the amount of data that is passing over a 
medium. Also, bandwidth is the portion of the frequency spectrum 
required to transmit desired information. Each radio channel has a 
center frequency and additional frequencies above and below this 
carrier frequency which is used to carry the transmitted information. 
The range of frequencies from the lowest to the highest used is called 
the bandwidth. 

 

Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 

 

Calibration : When making measurements, the instrument must be calibrated in 
order to remove residual errors due to measurement setup conditions. 
Anritsu recommends performing the calibration under the same 
conditions as the measurement: temperature, frequency, number of 
points, source power, and IFBW. Calibrations standards with known 
reflection coefficients are used to calculate the correction factors. The 
calibration must be conducted using the appropriate standards at the 
open end of any test port cables and adapters that are connected to the 
instrument. This ensures that the match, phase length, and loss of 
these cables and adapters are all accounted for. For optimal 
performance, high quality phase-stable cables and precision adapters 
must be used. 

 

Cell Site : Cell Site, also called Base Station, is the local cellular tower and radio 
antenna (including the radios, controller, switch interconnect, etc.) that 
handles communication with subscribers in a particular area or cell. A 
cellular network is made up of many cell sites, all connected back to the 
switch via landline or microwave. 
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Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

 

CW : Continuous Wave (CW) 

 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 

 

dB : Decibel or deciBel (dB) is a logarithmic ratio of the difference between 
two values (a logarithm ratio is equal to 10 times). dB is a unit for 
measuring relative power ratios in terms of gain or loss. The units of dB 
are expressed in terms of the logarithm to base 10 of a ratio and 
typically are expressed in watts. For example, a -3 dB loss indicates a 
50% loss in power; a +3 dB reading is a doubling of power; 10 dB 
indicates an increase (or a loss) by a factor of 10; 20 dB indicates an 
increase (or a loss) of a factor of 100; 30 dB indicates an increase (or a 
loss) by a factor of 1000. Common values of dB expressed in ratios: 0 dB 
= 1:1, 10 dB = 10:1, 20 dB = 100:1, 30 dB = 1000:1, -30 dB = 0.001:1 [or 
(1/1000):1]. 

 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. Typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 
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dBm : dBm is an absolute measurement of power relative to 1 milliwatt. In 
other words, dBm is a decibel value referenced to a milliWatt (dBm). 
This is a technique for expressing a power measurement in logarithmic 
form using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts 
(W) to one milliwatt (1mW). dBm, therefore, represents absolute power. 
Examples are: 0 dBm = 1.0 milliwatt, 10 dBm = 10 milliwatt, 30 dBm = 
1000 milliwatt = 1 watt. 

 

DHCP : Dynamic Host Configuration Protocol (DHCP) 

 

DSP : Digital Signal Processing (DSP) 

 

DTF : Distance-To-Fault (DTF) is the distance from the instrument output 
connector (or the end of a test lead) to a problem area, as indicated by a 
peak in the displayed signal. DTF measures the location and reflection 
size of impedance mismatches. This is typically a diagnostic 
measurement, not a pass/fail judgement measurement. DTF is used to 
identify and locate faults within an antenna system when the system is 
failing to meet the specified return loss or VSWR limits. DTF is also 
useful to verify the total length of a coaxial cable assembly. 

 

DTP : Distance-To-PIM (DTP), where PIM is Passive Intermodulation. DTP is 
the distance from the PIM Master output connector (or the end of a test 
lead) to a problem area, as indicated by a peak in the displayed signal. 

 

FFT : Fast Fourier Transform (FFT) is an efficient algorithm to compute the 
Discrete Fourier transform (DFT) and its inverse. FFTs are of great 
importance to a wide variety of applications, from digital signal 
processing to solving partial differential equations to algorithms for 
quickly multiplying large integers. 

 

Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. It is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. It is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 
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GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 meters to 100 meters. 
The satellites use simple mathematical calculations to broadcast 
information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

 

Impedance : Impedance is a measure of RF component electrical resistance, 
measured in ohms. In most cable and antenna systems, the standard 
impedance is 50 ohms. 

 

Insertion Loss : Insertion Loss (or Cable Loss) is a measure of the total amount of signal 
energy absorbed (lost) by the cable assembly. It is measured in dB. S21 
(an S-Parameter) is another name for this measurement. 

 

IP Address : An Internet Protocol address (IP address) is usually a numerical label 
that is assigned to each device (computer or printer for example) that is 
participating in a computer network that uses the Internet Protocol for 
communication. An IP address serves two main functions: location 
addressing and host (or network) interface identification. The Internet 
Protocol originally defined an IP address as a 32-bit number. This was 
known as Internet Protocol Version 4 (IPv4), which is still in use. 
Growth of the Internet requires a new addressing system. An Internet 
Protocol Version 6 (IPv6) that uses 128 bits for the address was 
developed in 1995, and it is standardized as RFC 2460. IPv6 began 
being deployed worldwide in the year 2000. IP adresses are binary 
numbers, but they are usually stored in text files and displayed in 
human-readable notations, such as decimal nnn.nnn.nnn.nnn or 
172.16.255.1 (for IPv4), and hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (for IPv6). In IPv4, each decimal 
group (nnn) represents values from 000 to 255, or binary values of 8 
bits. In IPv6, each hexadecimal group (nnnn) represents values from 
0000 to FFFF, or binary values of 16 bits (0000 0000 0000 0000 to 1111 
1111 1111 1111). 
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IPv6 : Internet Protocol Version 6 (IPv6) is a numerical label that is used to 
identify a network interface of a computer or other network node 
participating in an IPV6-enabled computer network. IPv6 uses 128 bits 
for the address (as compared to an IPv4 address, which is defined as a 
32-bit number). Pv6 was developed in 1995, and it is standardized as 
RFC 2460. V6 began being deployed worldwide in the year 2000. I 
addresses are binary numbers, but they are usually stored in text files 
and displayed in human-readable notations, such as hexadecimal 
nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn.nnnn or 
2C01:AB18:0:1234:FF03:567C:8:1 (where FFFF [Hex] = 65535 [Dec]). 
Ea hexadecimal group (nnnn) represents values from 0000 to†FFFF, or 
binary values of 16 bits (0000 0000 0000 0000 to 1111 1111 1111 1111). 

 

LST : Line Sweep tools (LST) is PC-based post-processing software that 
efficiently manipulates line sweep and PIM traces for reporting 
purposes. 

 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. F (the noise figure) is defined 
as the decibel value of the noise factor. NF = 10log (F) where log uses 
the base 10, or common log. This formula is valid only then the input 
termination is at standard noise temperature. 

 

OSL : OSL or Open Short Load calibration method for coaxial line types. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
SSL or Offset Short 1, Offset Short 2, Load calibration method for 
waveguide line types. 

 

OSLT : OSLT or Open Short Load Thru calibration method for coaxial line 
types. Calibrations standards with known reflection coefficients are 
used to calculate the correction factors. Refer to Calibration. Compare 
this with SSLT or Offset Short 1, Offset Short 2, Load, Thru calibration 
method for waveguide line types. 
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OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 

 

PIM : Passive Intermodulation (PIM) (interference) PIM is a form of 
intermodulation distortion that occurs in passive components normally 
thought of as linear, such as filters, combiners, surge protectors, cables, 
connectors, and antennas. When subject to the high RF powers found in 
cellular systems, these devices can generate spurious signals. PIM 
shows up as a set of unwanted signals created by the mixing of two or 
more strong RF signals in a non-linear device, such as in a loose or 
corroded connector, or in nearby rust. Other names for PIM include the 
diode effect and the rusty bolt effect. 

 

Return Loss : Return Loss is a measurement (in dB) of reflected energy caused by 
impedance mismatch. May also be referred to as S11. Although S11 
values are expressed as negative numbers, Return Loss values are 
expressed as positive numbers because by definition the ìLossî 
expression implies a negative sign. The higher the value, the better the 
impedance match (think of a large negative number being less than a 
smaller negative number). 40 dB is nearly ideal. Only 0.01 % of the total 
transmitted power is reflected if the Return Loss measurement value is 
40 dB. A measured value of 0 dB would be a complete reflection, or 
stated another way, 100 % of the transmitted power is reflected back. 
Return Loss is typically a pass/fail measurement. 

 

RF : Radio Frequency (RF) is the frequency of radio sine waves. RF generally 
refers to wireless communications within a frequency range of 3 kHz to 
300 GHz. Formally, according to the Article 2 of the Radio Law, radio 
frequency is below 3,000 GHz. Radio frequencies can be used for 
communications between a mobile telephone and an antenna mast. 

 

SCPI : Standard Commands for Programmable Instruments (SCPI) 
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SOLT : SOLT or Short Open Load Thru calibration method for coaxial line 
types with simple and redundant standards. It is not band-limited. It 
requires well-defined standards. It has lower accuracy at higher 
frequencies. Calibrations standards with known reflection coefficients 
are used to calculate the correction factors. Refer to Calibration. 
Compare this with SSLT or Offset Short 1, Offset Short 2, Load, Thru 
calibration method for waveguide line types. 

 

SSL : SSL or Short Short Load or Offset Short 1, Offset Short 2, Load 
calibration method for waveguide line types uses Shorts with different 
offset lengths. It is a calibration (common in waveguide) with simple 
and redundant standards, but it is band-limited. It requires 
well-defined standards. It has lower accuracy at higher frequencies. 
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
OSL or Open Short Load calibration method for coaxial line types. 

 

SSLT : SSLT or Short Short Line Thru or Offset Short 1, Offset Short 2, Load, 
Thru calibration method for waveguide line types uses Shorts with 
different offset lengths. It is a calibration (common in waveguide) with 
simple and redundant standards, but it is band-limited. It requires 
well-defined standards. It has lower accuracy at higher frequencies. 
Offset Short 1 is 1/8 wavelength, and Offset Short 2 is 3/8 wavelength. 
Calibrations standards with known reflection coefficients are used to 
calculate the correction factors. Refer to Calibration. Compare this with 
OSLT or Open Short Load Thru calibration method for coaxial line 
types. 

 

VSWR : Voltage Standing Wave Ratio (VSWR). VSWR is another method to 
measure reflected energy caused by impedance mismatch. It is 
expressed as a ratio of X:1. VSWR measures the voltage peaks and 
valleys. A ratio of 1:1 would be a perfect match. A typical cable and 
antenna system would be around 1.43:1 (VSWR) or 15 dB Return Loss. 

 

Watt : Watt (W) is a unit of measure for power. 
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